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INSTRUCTOR NOTES
Preparing the classroom

To provide the Adobe Premiere Pro CC student with the best experience possible, 
we recommend that the college lab or classroom provide the following:

•	 The appropriate hardware and software described in the following sections

•	 All software and course materials installed, configured, and tested at least one 
day prior to the start of the class

•	 A conducive learning environment including projector, whiteboards, and ample 
space for the students

Classroom requirements
•	 A computer workstation for each student enrolled in the class that meets the 

recommended system requirements available at Adobe.com. The machines 
must have at least 6 GB of RAM installed (12 GB is highly recommended).

•	 The student workstations should offer headphones for audio monitoring. 
Students can also be offered the opportunity to use their own.

•	 A computer workstation for the instructor that meets the recommended 
system requirements for Adobe Premiere Pro CC available at Adobe.com. If 
possible, all workstations should have a supported CUDA or Open GL graphics 
card. It also should have amplified speakers. The teacher’s station should have 
Internet access to show online resources and administer updates as needed. The 
instructor machines must have at least 8 GB of RAM installed (12 GB is highly 
recommended).

•	 A projector capable of showing a signal of at least 1280 x 900 pixels with a 
rating of at least 2000 lumens. A screen of at least 6 feet across should also be 
available.

•	 A whiteboard with dry-erase markers in clear view of the students.

•	 A flip chart with paper and markers should also be available.

•	 Lighting in the room must be able to be dimmed to improve the readability 
on-screen.

Classroom media and student machines
Each student enrolled in the class should purchase a copy of Adobe Premiere Pro 
CC Classroom in a Book. This book is sold by Peachpit to authorized training cen-
ters and campus bookstores. For Adobe authorized training centers in the United 
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States, please contact cindy.webster@pearson.com. For education customers in the 
U.S., please contact your local Pearson representative (www.pearsonhighered.com/
educator) or call 800-922-0579. For all International orders, contact international@
pearsoned.com. 

For each course, student machines should be reset to a refreshed state. This 
includes reset preferences and workspaces, as well as new copies of project files. 
System utilities such as Deep Freeze, Sandboxie, or Returnil can be used to stream-
line this process. A backup image of project files and software installers should 
be kept readily available to restore student machines when necessary. Students 
may need their own media hard drive. Please ensure that the connection and disk 
speeds are appropriate for digital video. Student machines should be reset to a 
refreshed state at the start of each session. A backup image of project files and soft-
ware installers should be kept readily available to restore student machines when 
necessary.

Instructional approach
Your goal as an instructor is to provide a nurturing environment that respects the 
past experiences of the students while ensuring that all students can learn and 
grow. Students may need positive reinforcement and additional examples to better 
understand and use the application.

•	 At the start of each module, review the objectives and time suggestions for the 
module.

•	 Use the “Getting started” sections as source material for your introduction to 
each module.

•	 During each module, enhance the course with your relevant, real-world 
experiences.

•	 Ask questions during the module to gauge comprehension.

•	 After each module, use the review questions so students can self-assess their 
understanding of the material. These questions are a useful way to prepare for 
the Adobe certification exam, but they are not questions that appear on an 
exam.

•	 Please endeavor to use proper Adobe terminology to describe components of 
the software. This will better prepare students for certification and enable them 
to use proper language when searching the Web or additional resources.

•	 Time management is critical so that you can provide balanced coverage of the 
lessons in the Adobe curriculum. The class is structured with recommended 
timings to assist you in covering all content areas. Please do not drop lesson 
files from the Adobe curriculum.
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Additional resources
Additional resources are identified within modules so you can expand the educa-
tional offerings to the students. Please suggest that your students choose these titles 
from www.peachpit.com or their favorite book retailer.

Adobe Premiere Pro CC: Learn by Video

Digital Video with Adobe Creative Cloud Classroom in a Book

Adobe After Effects CC Classroom in a Book

Adobe Photoshop CC Classroom in a Book

An Editor’s Guide to Adobe Premiere Pro (Second Edition)

Module 1: Touring Adobe Premiere Pro CC
•	 This module uses Lesson 1 in Adobe Premiere Pro CC Classroom in a Book.

•	 Please note that certain sections of the book have been dropped to conserve 
time. Please teach only the headings listed here.

This first lesson gives your students an opportunity to meet Adobe Premiere Pro 
and to familiarize themselves with the most important panels and tools.

When introducing each part of the interface, be sure to explain why and when 
users would use them. For example, explain that the trimming tools are for adjust-
ing the timing of edits already applied to a sequence and that it is most common to 
make trimming adjustments in the later phases of editing.

This lesson represents an excellent opportunity to create curiosity about features 
and interface elements that you’ll fulfill later.

Getting started (p. 8)

Nonlinear editing in Adobe Premiere Pro (p. 8)

•	 Presenting the standard digital video workflow (p. 9)

•	 Enhancing the workflow with Adobe Premiere Pro (p. 10)

Expanding the workflow (p. 11)

•	 Incorporating other CC components into the editing workflow (p. 12)

•	 Adobe pro video workflow (p. 13)

Touring the Adobe Premiere Pro interface (p. 14)

•	 The workspace layout (p. 15)

•	 Customizing your workspace (p. 18)

•	 Introducing preferences (p. 21)
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Goals and objectives for this lesson
By the end of this lesson, students should feel they can navigate the Adobe 
Premiere Pro interface, choose between (and reset) workspaces, and have a basic 
understanding of the way each part of the interface fits into common post-produc-
tion workflows.

Nonlinear editing in Adobe Premiere Pro CC
It’s common for students to have the wrong meanings attached to words associated 
with nonlinear editing. Be sure to clarify terms at this early stage to avoid confu-
sion later. 

The section “Presenting the standard digital video workflow” is particularly impor-
tant, because it provides context for learning during later lessons. It’s common, in 
the classroom, for students to click around the interface while listening to workflow 
descriptions, and this can sometimes result in problems with lesson files if they 
make changes without realizing it.

Consider having your students quit Adobe Premiere Pro while showing the work-
flow, and alternate between showing your own screen and using diagrams you draw 
on a whiteboard as you go through the key workflow stages.

Enhancing the workflow with Adobe Premiere Pro
This part of the lesson does an excellent job of impressing the reader with the fea-
tures available in Adobe Premiere Pro. Although this is useful for readers following 
the book alone at home, in the classroom you may find the amount of information 
is overwhelming for your students. In particular, there are features described that 
may not yet be meaningful for your students.

Consider skimming this section or revisiting it at the end of the course to give your 
students a perspective on when Adobe Premiere Pro can help them “fix it in post” 
(and when they need to get it right on location).

Expanding the workflow
Equally, the long list of additional components included with Adobe Creative Cloud 
might be overwhelming for a new class.

Consider focusing on the additional products you will be teaching in other, associ-
ated lessons or summarizing the core functionality of each component in a way 
that helps students “file away” the purpose of the product for future reference.

For example, you could say that Adobe Premiere Pro is primarily for video editing, 
while Adobe After Effects is primarily for effects. While these descriptions dramati-
cally simplify the broad range of features these two applications offer, they will help 
your students remember Adobe Premiere Pro and other components.
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Touring the Adobe Premiere Pro interface
Once you have given your students the context and the workflow, this is an 
opportunity to show how each part of the Adobe Premiere Pro interface meets one 
demand or another for editors.

There is a lot to show! To avoid information overload, considering picking a subset 
of panels and focusing more attention on them. Also, be sure to place emphasis on 
the flexible, adaptable interface. Panel positions and sizes can vary a lot from one 
editing system to the next, and this can be confusing for new users. Be sure your 
students understand how to reset a workspace to quickly find their bearings again.

These are the core interface components you might want to focus the most atten-
tion on:

•	 Project panel

•	 Timeline

•	 Source Monitor

•	 Program Monitor

•	 Media Browser

•	 Tools panel

•	 Effects panel

•	 Audio Mixer

Review questions

Q	 What is the name of the panel where you can view and trim raw clips?
A	 The Source Monitor panel.

Q	 Name the panel that reflects what is happening in the sequence.
A	 The Program Monitor panel.

Q	 What is the name of the panel where you can organize your source materials?
A	 The Project panel.

Q	 How does the History panel work?
A	 The History panel tracks the steps you take and lets you back up easily. It’s a 

kind of visual Undo list. When you select a previous step, all steps that came 
after it are also undone.

Q	 Where can you adjust the brightness of the interface?
A	 Use the Brightness preference (located in the Appearance category).
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Q	 How do you reset a workspace?
A	 Having chosen the workspace you want, go to Window > Workspace > Reset 

Current Workspace, and click Yes in the confirmation dialog.

Q	 What is the important distinction between the Audio Mixer panel and the 
Effect Controls panel?

A	 The Audio Mixer makes changes exclusively to audio tracks, while the Effect 
Controls panel makes changes exclusively to clip segments.

Q	 How can you show or hide transport controls on the Source and Program 
Monitors?

A	 Click the Source or Program Monitor panel menu, and select Show Transport 
Controls.

Q	 If you have too many panels in the same frame, one or more panel tabs may not 
be visible. How can you access the missing panels?

A	 Select the panel you want in the Window menu, or hover the mouse over the 
tabs in the frame and use the mouse wheel to scroll through the tabs. You can 
also use the small navigator that appears above the tabs to scroll through them.

Q	 How do you close a panel?
A	 Click the X on the panel’s tab.

Q	 Why might it be important to have a television monitor to display the contents 
of your sequence while you work?

A	 Computer monitors and television screens use different color systems. It’s 
important to view your video content on the kind of screen it is intended for.

Module 2: Setting Up a Project
•	 This module uses Lesson 2 in Adobe Premiere Pro CC Classroom in a Book.

•	 Please note it is not necessary to cover preferences in detail. Rather, revisit and 
customize preferences in the context of lessons throughout the course.

•	 Please note, certain sections of the book have been dropped to conserve time. 
Please teach only the headings listed here.

•	 Lesson 2 is a natural continuation of Lesson 1. Now that your students have 
an overall familiarity with the Adobe Premiere Pro interface and a sense of the 
workflow, from acquisition to output, they can create a new project.

•	 Many of the factors that you discussed during Lesson 1 will be relevant here, so 
it’s a good opportunity to reinforce understanding.
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Because it can be a source of confusion for new editors, be sure to emphasize the 
difference between projects and sequences. It’s particularly important that editors 
understand what conforming is and the role that sequence settings play in defining 
output.

Getting started (p. 26)

Setting up a project (p. 27)

•	 Video rendering and playback settings (p. 28)

•	 Video/audio Display Format settings (p. 31)

•	 Capture Format settings (p. 33)

•	 Scratch Disks settings (p. 34)

Setting up a sequence (p. 38)

•	 Creating a sequence that automatically matches your source (p. 38)

•	 Choosing the correct preset (p. 39)

•	 Customizing a sequence (p. 41)

•	 Understanding audio track types (p. 43)

Sidebars for discussion as time allows

•	 What do rendering and real time actually mean? (p. 29)

•	 The Mercury Playback Engine (p. 31)

•	 About seconds and frames (p. 32)

•	 Typical drive setup and network-based storage (p. 35)

•	 Media best practice (p. 36 and 37)

•	 Maximum bit depth and maximum render quality (p. 42)

•	 Formats and codecs (p. 42)

Adobe Mercury Playback Engine performance

•	 Real-time workflow

•	 Operating system requirements (64-bit) [Win|Mac]:  www.adobe.com/
products/premiere/tech-specs.html

•	 Recommended graphics hardware: GPU, VRAM

•	 Understanding hardware: RAM, CPU, and disk bandwidth

Goals and objectives for this lesson
On completion of this lesson, students will be able to start Adobe Premiere Pro, 
create a new project, and create a new sequence.
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Although it’s important that your students understand the New Project and New 
Sequence settings, the list of new things to learn and understand is quite long. 
When working with the New Sequence settings, consider focusing on the right 
options for the video format your students will be using, and explain that there are 
appropriate options for other formats.

Setting up a project
Most of the settings described make sense, but only if you are already familiar with 
the concepts they relate to. Be prepared to give some short, clear explanations for 
concepts including rendering, timecode, and capture.

This is a good opportunity to highlight the way Adobe Premiere Pro stores creative 
decisions inside a project file and to note that there is nothing unique about project 
files relative to other files on your hard drive. It’s also a good opportunity to note 
that Adobe Premiere Pro does not store video inside the project file, so it’s impor-
tant to know where your files are before you import them.

The Video and Audio Display Format options relate, of course, to the way time is 
measured, but the names of these settings can be confusing for new users. It’s a 
good idea to highlight the way the name might seem misleading, before explaining 
each of the options.

While your students may not yet understand the difference between audio samples 
and milliseconds, describing the purpose of the Audio Display Format menu may 
be a good opportunity to introduce the concept of audio samples. This kind of 
foreshadowing of later learning can be very effective, provided it does not take you 
off-topic too much.

Setting up a sequence
It’s often easier to focus on presets when introducing sequence settings for the first 
time. Depending on the level of experience of your students, you may want to sum-
marize this part of the lesson by focusing on the presets and showing the Settings 
tab as the place to make changes if desired.

Adobe Premiere Pro can automatically create a sequence that matches your media 
if you drag and drop a clip in the Project panel onto the New Item menu button. If 
you are working with a less experienced class, consider emphasizing this option so 
they are not overwhelmed by the potentially long list of new concepts highlighted 
by the Settings panel.

Tracks tab
Adobe Premiere Pro CC has advanced audio track and sequence audio master 
options. In most cases, standard audio tracks and a stereo master will work. The 
option to choose adaptive tracks and multitrack mastering is powerful but requires 
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a lot of explaining if students are used to working only with stereo audio. Note that 
Adobe Premiere Pro CC supports up to 32 channel mastering.

Once again, depending on how experienced your students are, you may find it 
effective to focus on the types of tracks and mastering they need for their immedi-
ate work and make sure they understand the purpose of the options. For example, 
the option to preset the pan/balance for each track may be useful if you know you 
will be working with stereo audio separated across two tracks.

It’s important for your students to understand that many of the options here, and 
elsewhere in Adobe Premiere Pro, serve a very particular need that may or not 
apply in every editing session. Also, many of the options are only a question of per-
sonal preference. Explaining this may help to pre-answer a lot of questions, where 
students may worry they have not understood how to proceed unless they under-
stand every option from the beginning.

Review questions

Q	 What does Open Project on the Welcome screen allow you to do?
A	 Lets you browse to an existing project file and open it to continue working on it.

Q	 Name the two types of views in the Project panel.
A	 You can choose between List View and Icon View.

Q	 How do you use the filter capability in the Project panel?
A	 By typing the first few letters of a name or keyword into the Find box, the bins 

will automatically expand and reveal any clips that match those typed letters.

Q	 What are the two choices in the Renderer menu?
A	 Mercury Playback Engine GPU Acceleration and Mercury Playback Engine 

Software Only.

Q	 By default does Adobe Premiere Pro use a project-based setup or a system-
based setup?

A	 A project-based setup.

Q	 What are the four types of audio tracks that you can create in Adobe Premiere 
Pro CC?

A	 Standard, 5.1, Adaptive, and Mono.

Q	 What happens when you render part of a sequence?
A	 Adobe Premiere Pro creates a new video file that looks like the composite result 

of your special effects work and video layers.
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Q	 Which project settings can you change later?
A	 You can change all of the project settings at any time. You cannot rename a 

project file or move it, however, while you are using it.

Q	 Should you base your sequence settings on your source video file format or your 
desired output format?

A	 It’s generally better to base sequence settings on your original video file format. 
This way, it’s less work for your computer to play the video, you’ll get better 
playback performance, and you won’t be changing the picture, potentially 
degrading it. You can output to multiple formats and resolutions at the end of 
your edit.

Q	 What are audio samples?
A	 Digital audio recording systems capture, or take a sample of, the amplitude 

of sound many times each second. The more times a second, the higher 
the maximum frequency that can be recorded. Professional video cameras 
commonly record 48,000 samples each second.

Q	 What is the maximum number of channels Adobe Premiere Pro will allow you 
to master to?

A	 Adobe Premiere Pro can master up to 32 channels of audio for professional 
soundtrack finishing.

Module 3: Importing Media
•	 This module uses Lesson 3 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate

•	 Please note, certain sections of the book have been dropped to conserve time. 
Please teach only the headings listed here.

Lesson 3 focuses on the next stage for a real-world project: the importing of source 
footage. It is important to emphasize to students that no two projects are ever the 
same. Similarly, they may encounter different tape or digital formats for each job. 
It is essential that they have a solid understanding of how to load or import footage 
and media (which leads directly to the next step, editing).

Getting started (p. 48)

Importing assets (p. 48)

•	 When to use the Import command (p. 48)

•	 When to use the Media Browser (p. 48)

Working with the Media Browser (p. 51)
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•	 Using a tapeless workflow (p. 51)

•	 Supported video file types (p. 52) [quick overview]

Finding assets with the Media Browser (p. 53)

Importing images (p. 55)

•	 Importing flattened Adobe Photoshop files (p. 55)

•	 Importing layered Adobe Photoshop files (p. 56)

•	 An introduction to Dynamic Link (p. 56)

•	 Image tips for Adobe Photoshop files (p. 58)

•	 Importing Adobe Illustrator files (p. 58)

The media cache (p. 61)

Tape vs. Tapeless Workflow (p. 62)

Goals and objectives for this lesson
The student should learn the essential techniques needed for importing digital 
footage, images, and audio. The benefits of using the Media Browser panel should 
also be clear in relation to working with tapeless recording formats.

Importing assets
There are two primary methods for importing footage into an Adobe Premiere Pro 
project. The first, using the Import menu, is designed for self-contained assets such 
as graphics and audio. Make sure students understand that when they import items 
into an Adobe Premiere Pro project, only a link is created. This means that the 
footage must first be copied to a drive and that drive must remain connected when 
working on the project.

Working with the Media Browser
The Media Browser is an easy way to view media for import (especially if it is com-
ing from a video camera). In this lesson, students will import media from a folder 
that simulates a camera memory card. The footage must first be copied to a local 
hard drive; do not attempt to work off the DVD-ROM inside Adobe Premiere Pro. 
To learn more about the DVD, see the “Getting started” section in the Introduction.

Importing Images
The two most common software tools used to create images or graphics are Adobe 
Photoshop and Adobe Illustrator. Because these tools are made by Adobe, there 
is an unparalleled level of integration between these applications. You can easily 
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import layered files for animation into Adobe Premiere Pro. Other important infor-
mation such as transparency also seamlessly transfers.

The media cache
The media cache is a great mystery to most users. It is important to know its role as 
well as location. If errors with files occur, you may need to know how to clear out 
the cache and rebuild it. Similarly, choosing where to store the cache is an impor-
tant decision when dealing with networked drives or a multisystem workflow.

Capturing from videotape
Tape itself is a medium that is moving toward obsolescence; however, many profes-
sional and semiprofessional workflows still rely on it. Capturing from videotape 
may not be a practical experience in the classroom because of hardware limita-
tions. Additionally, the use of third-party capture cards is common in professional 
workflows. Ideally, an affordable solution such as a DV or HDV deck can be used to 
help the student understand the process of capturing from tape.

Review questions

Q	 Name three ways to invoke the Import command.
A	 Double-click in the Project panel, press Control+I (Windows) or Command+I 

(Mac), or choose File > Import.

Q	 What are four major advantage of using the Media Browser?
A	 Narrowing the display to a specific file type, autosensing camera data, viewing 

and customizing the display of metadata, and correctly displaying media that 
has spanned clips multiple camera media cards.

Q	 List at least five supported file types.
A	 The following are all valid:

•	 H.264 as a .mov or .mp4 file
•	 Panasonic P2 (DV, DVCPRO, DVCPRO 50, DVCPRO HD, AVC-Intra)
•	 RED ONE, RED EPIC, and the RED Mysterium X
•	 ARRIRAW
•	 XDCAM SD, XDCAM EX, XDCAM HD, and HD422
•	 Sony HDV (when shot on removable tapeless media)
•	 AVCHD cameras
•	 Canon XF
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Q	 When importing a layered Adobe Photoshop document, what are your four 
options?

A	 You can choose Merge All Layers, Merged Layers, Individual Layers, or 
Sequence.

Q	 What is the benefit of the media cache?
A	 It greatly improves the performance for previews.

Q	 Does Adobe Premiere Pro copy footage from cameras such as P2, XDCAM, or 
AVCHD?

A	 No, it merely links to them. So, if you want to save the camera media, it’s 
important to copy it first and then link to the files on your hard drive. If you 
need a log and transfer style workflow use Adobe Prelude.

Q	 Is copying the raw file from a card to your hard drive enough?
A	 For best results, you should copy the entire folder’s structure. Without the 

folder’s complete structure, much of the information could be missing, 
including the audio and metadata. It is even possible for the video data to be 
unusable.

Q	 Is the codec of the sequence important to Adobe Premiere Pro?
A	 No, timelines aren’t codec specific. Use a sequence preset that most closely 

matches your primary format used to edit or that matches your delivery 
requirements.

Q	 Name two types of tape-based media Adobe Premiere Pro can capture without 
third-party hardware.

A	 DV and HDV can be acquired using your computer’s FireWire port 0r a 
FireWire to Thunderbolt adapter.

Module 4: Organizing Media
•	 This module uses Lesson 4 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.

•	 Please note, certain sections of the book have been dropped to conserve time. 
Please teach only the headings listed here.

As file-based cameras become more available, it is increasingly important to care-
fully manage data and organize projects to deal with the substantial number of files 
created while filming. Though the subject of staying organized may not be the most 
exciting, it is vital to plan ahead, saving time and effort later.



16  INSTRUCTOR NOTES

Getting started (p. 66)

The Project panel (p. 66)

•	 Customizing the Project panel (p. 67)

•	 Finding assets in the Project panels (p. 69)

Working with bins (p. 72)

•	 Creating bins (p. 72)

•	 Managing media in bins (p. 73)

•	 Changing bin views (p. 74)

•	 Assigning labels (p. 76)

•	 Customizing bins (p. 77)

•	 Having multiple bins open at once (p. 79)

Organizing media with content analysis (p. 79)

•	 Using the Adobe Story panel (p. 80)

•	 Speech analysis (p. 80)

Monitoring footage (p. 82)

•	 Essential playback controls (p. 85)

•	 Customizing the monitors (p. 86)

Modifying clips (p. 87)

•	 Adjusting audio channels (p. 87)

•	 Interpreting footage (p. 89)

•	 Working withraw files (p. 89)

Sidebars for discussion as time allows

•	 Finding your media (p. 73)

•	 Changing the available label colors (p. 76)

Goals and objectives for this lesson
As well as giving students some best-practice approaches to managing projects and 
media, this lesson provides a useful overview of the features and controls available 
in the Project panel. There are also several core concepts, such as the use of meta-
data, footage interpretation, and playback.

Adobe Premiere Pro CC has a highly effective bin-based clip navigation feature, 
called hover scrub. This feature allows you to examine, mark, and organize clips 
ready for an assembly edit, without needing to use the Source Monitor. Video 
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editing and marking clips are not covered fully until the next lesson, so try to avoid 
getting too caught up in making choices about what to include in a sequence.

The Project panel
The Project panel has a wider range of functions than might be apparent on first 
inspection. It’s worth taking your time with this important panel so your students 
feel comfortable finding their way around its menus and options.

Note that although you can turn on the Preview Area of the Project panel, it doesn’t 
add any functionality or information. When you hover your mouse over a clip, 
the size, pixel aspect ratio and frame rate, info, and so on, are displayed. Also, you 
can use the newly improved thumbnail display mode to play clips and change the 
representative poster frame.

While you teach your students how to search for items in the bin, it’s a good oppor-
tunity to highlight the benefit of investing a little time in good clip naming and 
metadata management.

Adobe Premiere Pro CC includes the option to sort clips while in Icon View. Unless 
the setting is left on User Order (which is the default), one cannot manually set the 
order of clips in Icon View. Be sure to guide your class back to the User Order set-
ting after learning this feature.

Working with bins
Bins are a little special in Adobe Premiere Pro, because they operate both as 
secondary containers for clips and as Project panels in their own right. It’s worth 
highlighting the way you can treat any bin as a Project panel, partly to show the 
benefit and partly to avoid confusion.

Though label colors are helpful, there is a limited supply in Adobe Premiere Pro. Be 
sure to let your students know that there are no spare label colors, so they’ll need 
to accept multiple items sharing the same color. This may not be an issue, as long as 
they know to expect it.

Metadata is a potentially enormous topic. For most editors, it is either mostly 
irrelevant or fundamentally vital. The difference is one of workflow. At this stage, it 
is helpful to show your students how easy it is to change the range of metadata dis-
played, where the options are, and ways in which it might be useful, but you might 
want to try to avoid lengthy discussions about practical applications.

Organizing media with content analysis
Automatic content analysis is a powerful feature for speeding up editing, by making 
it easier to locate a particular moment in footage. However, it’s worth emphasizing 
that the feature does not usually identify every word spoken with perfect accuracy.
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This is also an excellent opportunity to properly introduce the Metadata panel. 
Rather than going into every detail in this panel, consider emphasizing the flexibil-
ity of the Adobe XMP system and the way you can use the Metadata panel (and the 
Metadata display options in the Project panel) to display whatever metadata you 
need

Monitoring footage
Playing footage and making creative choices about it are the greater part of video 
editing. Thankfully, the controls are straightforward and relatively easy to learn. 
While describing the playback and In/Out marking buttons, it’s a good opportunity 
to highlight the distinction between clips in the Project panel and media files on 
the hard drive.

Understanding the particular relationship between the two is fundamental 
to understanding the way nonlinear editing systems work.

Modifying clips
This section can be taught in very simple ways, emphasizing the flexible way Adobe 
Premiere Pro allows you to change the interpretation of media files, or it can be the 
basis for a deeper dive into formats and the process of recording and reproducing 
light and sound.

While most students will understand the differences between mono, stereo, and 5.1 
audio, you may need to “begin again” when explaining adaptive audio.

While explaining safe margins, you may find it useful to also discuss the many 
display mediums available today and some of the challenges associated with pro-
ducing content for so many different screen sizes and contexts. Note that Adobe 
Premiere Pro CC includes crop lines for 4x3 displays with the safe margins.

Review questions

Q	 Name the two types of views in the Project panel.
A	 You can choose between List and Icon Views.

Q	 In the Project panel (in List View), how can you sort your items in alphabetical 
or reverse alphabetical order?

A	 Click the name heading at the top of the Project panel.

Q	 What are two sets of searches you can perform at the same time with the Adobe 
Premiere Pro Find panel?

A	 You can choose to display clips that match both search criteria or either search 
criteria.
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Q	 List three way you can create a new bin in Adobe Premiere Pro CC.
A	 Click the New Bin button at the bottom of the Project panel, right-clicking a 

blank area in the Project panel and choosing New Bin, drag and drop the clips 
onto the New Bin button at the bottom of the Project panel, and File menu. 
Choose File > New > Bin.

Q	 Name the two types of views in the Project panel.
A	 You can choose between List and Icon Views.

Q	 Which application performs the analysis for speech transcription?
A	 Adobe Media Encoder.

Q	 In which panel does speech analysis appear?
A	 The Metadata panel.

Q	 How can speech analysis be improved?
A	 By attaching a transcript or script.

Q	 Is it possible to edit to the Timeline from the Metadata window?
A	 Yes, and it’s a huge time-saver.

Q	 Is it possible to modify the transcribed text, and if so, how?
A	 Double-click any word to modify that word or right-click.

Q	 What is metadata?
A	 Metadata is data about data, in other words, information associated with your 

clips but not the contents of your clips.

Q	 How do you change the size of thumbnails in the Project panel?
A	 Click and drag the Zoom slider at the bottom of the Project panel, or click the 

Zoom Out or Zoom In button.

Q	 How can you change how a bin will display its contents when you double-click 
it in the Project panel?

A	 In the General preferences, you can choose what happens when you double-
click, Control+double-click (Windows) or Command+double-click (Mac), and  
Alt+double-click (Windows) or Option+double-click (Mac) a bin in the Project 
panel.

Q	 How can you use the J, K, and L keys to play your clips?
A	 In the Project panel (when in Icon View), the Source Monitor, the Program 

Monitor, and the Timeline panel, the J, K, and L keys start playback in reverse, 
pause playback, and play forward.
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Q	 What is timecode?
A	 Timecode is a way of measuring time in hours, minutes, seconds, and frames. 

The number of frames recorded per second can vary.

Q	 What is special about the way Adobe Premiere Pro can interpret RED camera 
and ARRI Alexi video files?

A	 RED and ARRI Alexa cameras record using a camera raw format. By right-
clicking a clip and choosing Source Settings, you can access the original 
interpretation of the video and make changes to it without affecting playback 
performance.

Module 5: Essentials of Video Editing
•	 This module uses Lesson 5 in the Adobe Premiere Pro CC Classroom in a Book.

•	 You may wish to skip past Lesson 4 in the Adobe Premiere Pro CC Classroom in 
a Book and begin with this lesson first.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate

•	 Please note, certain sections of the book have been dropped to conserve time. 
Please teach only the headings listed here.

The techniques in this lesson are relatively simple, but they are some of the most 
important your students will learn. Many professional editors do not need to know 
much more than the techniques described in this lesson, because they will produce 
a rough cut and then hand the work to another editor for fine finishing.

It’s the nature of these particular skills that your students are likely to need extra 
hands-on time to really understand what is happening when they make an edit. 
Even if time is pressing, try not to rush, in particular, the hands-on practice of 
standard three-point edits, because this basic operation is fundamental to under-
standing the relationship between Adobe Premiere Pro as an editor, project, clips, 
and sequences.

Getting started (p. 94)

Using the Source Monitor (p. 94)

•	 Loading a clip (p. 95)

•	 Loading multiple clips (p. 96)

•	 Source Monitor controls (p. 97)

•	 Selecting a range in a clip (p. 97)

•	 Creating subclips (p. 100)

Navigating the Timeline (p. 101)
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•	 What is a sequence? (p. 103)

•	 Opening a sequence in a Timeline panel (p. 104)

•	 Understanding tracks (p. 104)

•	 In and Out points (p. 106)

•	 Using time rulers (p. 108)

•	 Customizing track headers (p. 108) 

Essential editing commands (p. 109)

•	 Overwrite edit (p. 109)

•	 Insert edit (p. 110)

•	 Three-point editing (p. 112)

•	 Storyboard editing (p. 113)

Sidebars for discussion as time allows

•	 What happens if you use four points? (p. 112)

•	 Setting the duration for still images (p. 114)

Goals and objectives for this lesson
The goal of this lesson is to consolidate the understanding your students have of 
playback and interaction with the Source Monitor and to introduce core editing 
skills that will be developed in later lessons.

Aside from previewing and marking clips, students will learn about subclips, 
timeline controls, producing composite images by layering clips on different tracks, 
track patching, and storyboard editing directly from the Project panel.

Using the Source Monitor
It’s convenient that teaching the use of the Source Monitor effectively also teaches 
the use of the Program Monitor. You can go over the controls and options for 
the Source Monitor and then highlight the small number of differences between 
the two.

The Source Monitor makes extensive use of keyboard shortcuts, and this is a good 
opportunity to encourage your students to save time by using them. When students 
learn Adobe Premiere Pro, they often feel more comfortable using the mouse, 
rather than the keyboard, perhaps partly because they tend to learn by looking at 
the buttons first. However, there is a short list of particularly useful keyboard short-
cuts worth learning.

•	 I: Mark In

•	 O: Mark Out
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•	 Spacebar: Play/Stop

•	 J: Play reverse

•	 L: Play forward

•	 Left arrow: Step back one frame

•	 Right arrow: Step forward one frame

•	 , (comma): Insert

•	 . (period): Overwrite

Keyboard shortcuts are much easier to learn if you have a color-coded Adobe 
Premiere Pro keyboard.

Navigating the Timeline
The Timeline panel, along with the Source and Record Monitors, is one of the most 
important parts of the Adobe Premiere Pro interface. While most of the options 
will make sense right away to students, some parts may not be fully understood 
until you have gone through some hands-on exercises.

This section begins with a rather complex image, showing each button and control 
in the Timeline panel. Rather than going through every item before you proceed, 
you might find it more effective to work through the lesson, allowing your students 
to refer to the opening graphic when they need to do so.

Track targeting, or track patching, can be confusing if it is taught as a concept, 
rather than demonstrated. It’s common for the technique to be demonstrated using 
multiple clips, potentially in multiple sequences. Consider demonstrating this tech-
nique using the same clip in the same, empty sequence. You can repeatedly edit the 
clip into the sequence, making adjustments to the track targeting teach time. This 
way, your students can see just one factor that produces a different result in the 
sequence, rather than multiple factors, such as clip length, thumbnail appearance, 
and clip name. 

Essential editing commands

This section is exciting, because it’s your students’ first opportunity to perform 
real edits. You can tell your students at the end of this section that they can now 
edit using Adobe Premiere Pro. There may be much for them still to learn, but 
the greater part of their work will involve repeating these important but simple 
techniques.

You may find it helpful to describe insert and overwrite edits or extract and lift 
edits as one of two approaches to video editing. Historically, you might have been 
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able to draw an analogy between tape-style editing or celluloid-style editing, but 
both of these are increasingly distant concepts for the majority of editors.

A more modern analogy might be to compare these two approaches to writing with 
a whiteboard, where content must be erased to be replaced and cannot be moved, 
and a word processor, where content can be moved, copied, and adjusted freely. 
Just describing nonlinear editing as word processing for video is enough for many 
students. However, it’s important for your students to understand the value of mak-
ing edits that do not change the position of existing clip segments in a sequence. 

Review questions

Q	 When automating your storyboard to a sequence, what are the two ordering 
options, and how do they work?

A	 Sort Order and Selection Order. If you choose Sort Order, the clips will be 
placed into the sequence in a left-to-right and top-to-bottom order as you 
arranged them in the Project panel. If you choose Selection Order, the clips will 
be placed in the order you selected them (clicked them) from the Project panel. 
You can select multiple clips sequentially by holding down the Command key 
(Mac) or the Control key (Windows) when clicking.

Q	 Where is the track lock button found, and what action is it used for?
A	 The track lock button is an empty square to the left of the disclosure triangle 

on each video and audio track. When selected, you will see a small padlock, 
and the track will have crosshatching. Locking a track prevents it from being 
modified accidentally.

Q	 What are the keyboard shortcuts to zoom in, zoom out, and fit on-screen for 
the Timeline?

A	 The equal sign (=) to zoom in, the minus sign (-) to zoom out, and the backslash 
key (\) to make the entire sequence fit on-screen.

Q	 If you make a mistake, you can go back and undo the error. What is the 
keyboard shortcut for undo?

A	 You can back up one step at a time using the keyboard shortcut Control+Z 
(Windows) or Command+Z (Mac). You can also access the Undo and Redo 
commands in the Edit menu. There are 32 levels of undo and redo.

Q	 If you drag a clip with In and Out points directly from the Project panel into a 
sequence in the Timeline panel, will the whole clip be added to the sequence or 
part of the sequence?

A	 Adobe Premiere Pro always honors In and Out points, so when you add a 
clip directly from a panel, only the part you have selected will be added to the 
sequence.
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Q	 How would you change the track targeting for your source video from Timeline 
track Video 1 to Video 2?

A	 Drag and drop the source track V selection button up to position it next to the 
Timeline Video 2 track.

Q	 What is conforming?
A	 Regardless of the frame rate, frame size, pixel aspect ratio, or field order, Adobe 

Premiere Pro will adjust the playback of clips edited into a sequence so that 
they match the sequence settings. This process of adjusting playback so that 
everything matches is conforming.

Q	 What’s the difference between a three-point edit and a four-point edit?
A	 A three-point edit has either In and Out marks in the Source Monitor or it has 

an In and Out mark in the Timeline. A four-point edit has both In and Out 
marks in the Source Monitor and In and Out marks in the Timeline. Four-point 
edits give you the option to automatically adjust playback speed for clips added 
to a sequence.

Q	 When storyboard editing, how do you set the order in which clips are added to 
a sequence?

A	 With your bin set to Icon View, drag and drop clips to position them left to right 
and top to bottom in the order you would like them to appear in the sequence.

Q	 What is the difference between a lift and an extra edit?
A	 A lift edit leaves a gap behind on the Timeline, while an extract edit closes the 

gap (unless sync locks prevent it).

Module 6: Working with Clips and Markers
•	 This module uses Lesson 6 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.

•	 Please note, certain sections of the book have been dropped to conserve time. 
Please teach only the headings listed here.

Once students understand the core editing techniques used to add clips to 
sequences, taught in the previous lesson, you’ll have a starting point for all of the 
remaining concepts in this course. Lesson 6 extends many of those core concepts 
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to include more advanced use of the Timeline panel and a further application of the 
insert and overwrite editing approaches.

It’s particularly important, while teaching this lesson, to ensure your students have 
all fully understood the techniques taught in the previous lesson. Because there 
is some repetition in the concepts used in this lesson, it represents an excellent 
opportunity to try alternative versions of edit and to see how your students get on 
with interacting with the Timeline unsupervised. Effectively, this is a good test of 
skills learned so far, without explicitly being a test.

Getting started (p. 120)

Program Monitor controls (p. 120)

•	 Adding clips to the Timeline with the Program Monitor (p. 122)

•	 Insert editing with the Program Monitor (p. 123)

Controlling resolution (p. 125)

•	 Playback resolution (p. 126)

•	 Paused resolution (p. 127)

Using markers (p. 127)

•	 Types of markers (p. 128)

•	 Automated editing to markers (p. 132)

Using Sync Lock and Track Lock (p. 133)

•	 Using Sync Locks (p. 133)

•	 Using Track Locks (p. 134)

Finding gaps in the Timeline (p. 134)

•	 Selecting clips (p. 135)

•	 Selecting a clip or range of clips (p. 135)

•	 Selecting all the clips on a track (p. 136)

•	 Selecting audio or video only (p. 137)

•	 Splitting a clip (p. 136)

•	 Linking and unlinking clips (p. 137)

Moving clips (p. 137)

•	 Dragging clips (p. 137)

•	 Rearranging clips in a sequence (p. 139)

•	 Using the clipboard (p. 140)
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Extracting and deleting segments (p. 141)

•	 Lift (p. 141)

•	 Extract (p. 142)

•	 Delete and Ripple Delete (p. 143)

•	 Disabling a clip (p. 144)

Sidebars for discussion as time allows

•	 The Program Monitor vs. the Source Monitor (p. 121)

•	 Choosing content (p. 125)

•	 Why are there so many ways to edit clips into a sequence? (p. 131)

Goals and objectives for this lesson
By the end of this lesson, your students will understand the difference between 
using the Source and Program Monitors, using markers, setting sync and track 
locks, making selections in a sequence, moving clip segments in a sequence, and 
removing clips from a sequence. Importantly, they will also develop confidence and 
familiarity while working with Adobe Premiere Pro.

Program Monitor controls
This is a good opportunity to highlight the multiple ways of achieving the same 
result while working with Adobe Premiere Pro. Sometimes, when learning to use 
an application, a user will understand one way to achieve something; then someone 
will show them another way of doing the same thing. This can undermine the con-
fidence the user has: Did they understand it correctly originally? Is there a better 
way they should know about?

By reinforcing that the technique is fine, as long as the result is correct, you’ll help 
your students build confidence in the techniques they have learned.

Controlling resolution
Up to this point, your students may have seen little difference in performance, 
regardless of their system specifications or the file types they are working with. This 
lesson introduces a RED camera .R3D file, which will tax even the most powerful 
systems.

This is a good opportunity to explain the benefits of having a more powerful com-
puter for more challenging playback situations, as well as the convenience of being 
able to drop playback and pause resolution.
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Using markers
Markers in Adobe Premiere Pro serve many roles while editing. They can assist 
with aligning clips, add important metadata, or create interactivity in uses such as 
web delivery and DVD. It is important that users can add, edit, and update markers 
easily.

Using sync lock and track lock
While track locks tend to make immediate sense to students, you may find they 
struggle, initially, to understand sync locks. This is perhaps partly because the 
default mode for all sync locks is on. You can demonstrate the benefit—and the 
danger—of using sync locks by turning them all off and performing some insert 
edits with video only or audio only.

Adobe Premiere Pro makes it very obvious when linked video and audio clip seg-
ments go out of sync, so your students should easily be able to see the difference 
the sync locks make.

Finding gaps in the Timeline
While the title of this section is about Timeline gaps, in fact this section includes a 
lot of important Timeline editing techniques. It’s helpful to highlight the distinction 
between editing sequences based on clip segments and editing based on In and 
Out marks.

Selecting is extremely important when working with Adobe Premiere Pro. Whether 
it is selecting the correct panel, the right clip, or the right part of a sequence, very 
often menus will appear to give the wrong options, or outcomes will vary from 
expectation if the wrong item is chosen before performing a technique.

This is an excellent opportunity to highlight this fact, because it is likely your stu-
dents will encounter a problem during this lesson caused by selecting wrongly.

Selecting clips
Note that the Track Select tool has reversed functionality in Adobe Premiere Pro 
CC. By default, the tool now selects all tracks. Holding the Shift key switches the 
tool to selecting a single track.

Moving clips
This section, and the next, makes perfect sense as a continuation of the insert 
and overwrite edits. Once your students understand the difference between the 
two, it should be relatively easy to introduce two further applications of those two 
approaches.
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It can be difficult to learn and memorize the various combinations of modifier keys 
used when dragging and dropping to move clip segments in a sequence. It may be 
easier to emphasize the kinds of modes available and encourage your students to 
experiment with the various modifier keys when they need them.

As long as your students understand the kinds of Timeline operations possible, it 
will be easy for them to experiment and memorize the correct modifier keys by 
practicing.

Review questions

Q	 How is the Snapping command used?
A	 When the Snapping command is active, two clips will snap together with 

“magnetic attraction” on the Timeline, leaving no gaps or flash frames between 
shots. The command can be invoked in three ways: by pressing the S key, 
choosing it from the Sequence menu, or clicking a button that looks like a small 
magnet in the upper-left corner of the Timeline panel. Snapping also allows you 
to drag an edit and “snap” it to wherever the playhead (current-time indicator) 
is located. Holding the Shift key will cause the Playhead to snap too.

Q	 How do Lift and Extract commands differ?
A	 The Lift command removes a clip or part of a clip and leaves a gap (space) in 

the Timeline. The Extract command not only removes the clip (media) but also 
ripples the remaining media to the left and closes the gap (space).

Q	 How can you find gaps in your Timeline?
A	 To find a gap in your Timeline, position the playhead (current-time indicator) 

at the start of your sequence and choose Sequence > Go to Gap > Next in 
Sequence.

Q	 What happens if you drag a clip from the Source Monitor into the Program 
Monitor?

A	 Adobe Premiere Pro will overwrite edit the clip into the current sequence, 
honoring In and Out marks and following the track targeting you have set up. If 
you use the Control (Windows) or Command (Mac) key while doing this, you’ll 
perform an insert edit instead.

Q	 How do you reduce the paused resolution for the Source Monitor or Program 
Monitor?

A	 Click the Settings menu or go to the Panel menu for the monitor you want to 
change, and choose Paused Resolution, followed by the resolution you would 
like.
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Q	 What is the keyboard shortcut to add a marker?
A	 The keyboard shortcut is M.

Q	 What’s the difference between a sync lock and a track lock?
A	 Sync locks ensure linked video and audio clip segments stay together in time, 

while track locks prevent any changes from being applied to the selected track.

Q	 When using the Track Select tool, which modifier key changes the way it 
functions to select all tracks, rather than clips on a single track?

A	 Use the Shift key to select all tracks using the Track Select tool.

Q	 When dragging and dropping a clip segment from one part of a sequence to 
another, which is the default type of edit—overwrite or insert?

A	 By default, you’ll make an overwrite edit. You can change this by holding the 
Control (Windows) or Command (Mac) key while dragging and dropping.

Module 7: Adding Transitions
•	 This module uses Lesson 7 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.

•	 Please note, certain sections of the book have been dropped to conserve time. 
Please teach only the headings listed here.

The use of transitions is a standard practice to help in narrative storytelling. The 
key is to help students learn restraint and balance. Adobe Premiere Pro does not 
offer a wealth of transitions; rather, it focuses on the core transitions most com-
monly used such as dissolves, dips, and wipes. This lesson will help students learn 
where to place transitions as well as how to modify them.

Getting started (p. 146)

What are transitions? (p. 146)

•	 When to use transitions (p. 147)

•	 Best practices with transitions (p. 147)

Edit points and handles (p. 146)

Adding video transitions (p. 149)

•	 Applying a single-sided transition (p. 150)

•	 Applying a transition between two clips (p. 151)

•	 Applying transitions to multiple clips at once (p. 153)

Sequence display changes (p. 155)
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Using A/B mode to fine-tune a transition (p. 156)

•	 Changing parameters in the Effect Controls panel (p. 156)

•	 Dealing with inadequate (or nonexistent) head or tail handles (p. 158)

Adding audio transitions (p. 160)

•	 Creating a crossfade (p. 161)

•	 Applying audio transitions (p. 161)

Goals and objectives for this lesson
When this lesson is complete, the students should understand what the role of a 
transition is (essentially to help resolve and indicate a change in location or time). 
To apply a transition, an editor must be able to select an edit point and work with 
the available handles of a clip (the overlapping parts that are normally hidden).

This lesson explores the use of both audio and video transitions. The students will 
also modify and fine-tune transitions to change their duration, location, and style. 
Additionally, time-saving techniques such as reusing a transition and applying tran-
sitions to multiple clips at once are covered.

What are transitions?
A transition creates an animation between two clips. This can be done with 
movement or by simply blending the two clips together by ramping their opacity. 
Transitions—such as dissolves, page wipes, spinning screens, and the like—provide 
a nice way to ease viewers from one scene to the next. What’s important to note is 
that transitions are often overused. Similarly, it’s important to not use such a great 
variety to the point that an edit lacks a cohesive appearance.

Edit points and handles
The first time a student is exposed to a transition, it is often difficult to grasp the 
concept of edit points and handles. It may become necessary to show a physical 
mock-up of a push wipe (where one source pushes off-screen and reveals another). 
If using the application, try to show transitions where the overlap is easy to see.

Point out that an edit point is the point in a Timeline where one clip ends and the 
next begins. These are easy to see because Adobe Premiere Pro draws vertical lines 
to show where one clip ends and another begins (much like two bricks next to each 
other).

To show a handle, revisit the original act of editing a clip into a sequence. Show the 
use of marks (leaving space before and after the In and Out points) so that handles 
remain. The handle between a clip’s Media Start time and In point is called the 
head material, and the handle between a clip’s Out point and Media End time is 
called the tail material.
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Be sure to point out that a small triangle can appear in the upper-right or upper-
left corner of a clip to indicate that the end of a clip has been reached. There are no 
additional frames past the beginning or the end of the clip. For transitions to work 
smoothly, you need handles. When your clip has handles, there are no triangles 
displayed in the upper corners of the clip.

Adding video transitions
To add transitions, you can show the Effects panel for the easiest drag-and-drop 
method. Advanced editors will also want to understand how to modify the default 
transition (a simple right-click on the desired effect) as well as apply the transition 
quickly (several shortcuts under the Sequence menu).

One area that is related to handles is the difference between a single-sided and a 
transition between clips. Show students how they can choose where a transition is 
placed (starting or ending at a cut as well as centered). Also, identify how a choice 
may be unavailable because of handles.

Using A/B mode to fine-tune a transition
The Effect Controls panel’s A/B editing mode splits a single video track into two 
subtracks. This makes it very easy to see the overlap between the clips as well as the 
available handles. Many editors find the visual feedback provided by this interface 
essential when placing transitions and modifying their properties.

Adding audio transitions
With only three audio transitions in Adobe Premiere Pro, many users rush right 
past the effects and don’t learn the subtle differences. This is an excellent time 
to ensure that students have working headphones and that they take the time to 
hear the difference. Checking this now will make the two audio lessons later in the 
course run more smoothly.

Because all audio is different, you’ll find three styles of crossfades to choose from.

•	 Constant Gain: The Constant Gain crossfade (as its name implies) transitions 
audio by using a constant audio gain (volume) between the clips. Some find 
this transition type useful. It can, however, create a very sudden transition in 
the audio as the sound of the outgoing clip fades out and the incoming clip 
then fades in at an equal gain. The Constant Gain crossfade is most useful in 
situations where you do not want much blending between two clips but rather 
more of a dip out and in between the clips.
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•	 Constant Power: The default audio transition in Adobe Premiere Pro creates 
a smooth, gradual transition between two audio clips. The Constant Power 
crossfade is very similar to how a video dissolve works. When applied, the 
outgoing clip at first slowly fades out and then fades out at a faster rate toward 
the end of the clip. On the incoming clip, the opposite occurs. The audio level 
increases quickly at the start of the incoming clip and slower toward the end 
of the transition. This crossfade is useful in most situations where you want a 
blending between clips.

•	 Exponential Fade: This effect is similar to the Constant Power crossfade. 
The Exponential Fade transition is a fairly smooth fade between clips. It uses 
a logarithmic curve to fade out and fade up audio. This results in very good 
natural blending between audio clips. Some prefer the Exponential Fade 
transition when performing a single-sided transition (such as fading in a clip 
from silence at the start or end of a program).

Review questions

Q	 Where would you find detailed adjustment controls for a transition you have 
placed in the Timeline?

A	 In the Effect Controls panel (with the transition selected). You can slip a 
transition, extend or shorten either side, change duration, adjust alignment, 
and easily see the handles on the adjacent clips. Depending on the transition, 
some parameters, such as wipe angles and borders, can be adjusted in the Effect 
Controls panel as well.

Q	 If one or both of your clips do not have enough handles (media) to cover the 
duration of the transition, what does Adobe Premiere Pro do?

A	 It creates a freeze frame to cover the needed frames. These still frames will be 
identified by a crosshatch in the transition overlay in the Effects panel and on 
the Timeline.

Q	 What does a red line above a transition indicate?
A	 The transition will need to be rendered before you can record to tape or create a 

file. You may still be able to play back a preview of the effect without rendering.

Q	 How can you apply a transition across multiple clips in a Timeline?
A	 Select the clips to which you want to apply the transition. Choose Sequence > 

Apply Default Transitions to Selection. You can change the default transition by 
right-clicking any transition in the Effects panel and choosing Set Selected as 
Default Transition.
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Module 8: Advanced Editing Techniques
•	 This module uses Lesson 8 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.

•	 Please note, certain sections of the book have been dropped to conserve time. 
Please teach only the headings listed here.

This lesson really delves deep into the powerful editing tools that Adobe Premiere 
Pro offers. For many, this lesson may take some time to “sink in” and become truly 
useful. Several advanced topics are covered, and if the student lacks previous edit-
ing experience, these topics may take some time to appreciate and integrate into 
their standard workflow. Try hard to give perspective on why these techniques are 
useful or save time.

Getting started (p. 166)

Four-point editing (p. 166)

•	 Editing options for four-point edits (p. 166)

•	 Making a four-point edit (p. 167)

Retiming clips (p. 168)

•	 Changing the speed/duration of a clip (p. 168)

•	 Changing speed and duration with the Rate Stretch tool (p. 170)

•	 Changing speed and duration with time remapping (p. 171)

Replacing clips and footage (p. 174)

•	 Dragging in a replacement clip (p. 174)

•	 Making a replace edit (p. 175)

•	 Using the Replace Footage feature (p. 177)

Nesting sequences (p. 179)

•	 Adding a nested sequence (p. 179)

•	 Nesting clips already in a sequence (p. 181)

Regular trimming (p. 182)

•	 Trim in Source Monitor (p. 182)

•	 Trim in a sequence (p. 183)

Advanced trimming (p. 184)

•	 Ripple edit (p. 184)

•	 Rolling edit (p. 187)
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•	 Sliding edits (p. 188)

•	 Slip edits (p. 190)

Trimming in the Program Monitor panel (p. 192)

•	 Using Trim mode in the Program Monitor (p. 192)

•	 Choosing a trimming method in the Program Monitor (p. 194)

•	 Dynamic trimming (p. 196)

•	 Trimming with the keyboard (p. 198)

Sidebars for discussion as time allows

•	 Recognizing the downstream effects of changing time (p. 174)

•	 Modifier keys (p. 196)

Goals and objectives for this lesson
The primary goals for this lesson can be summarized as speed and power. First, 
your students will learn how to perform a four-point edit, which can be useful for 
adjusting the timing of a clip to fill a specific duration. Additionally, other tech-
niques for adjusting the playback speed of clips will be explored.

The students will then learn several ways to replace footage. This includes swapping 
out one shot for another as well as making a permanent replacement at the project 
level. They’ll also learn how to group several clips into a nested sequence. This is 
a useful organization technique as well as opens up the ability for transforming a 
group of clips.

Lastly, the world of professional trimming will be explored. Students will perform 
both basic trimming on media to refine edits as well as advanced trimming. They’ll 
learn to use slip and slide edits to refine a clip’s position or content as well as 
dynamic trimming media using keyboard shortcuts.

Four-point editing
There are two reasons that your students will have a four-point edit. Typically, the 
standard technique is to use three-point editing. However, a student may acciden-
tally hit a fourth point. The short answer is that you have a discrepancy that must 
be resolved. Most likely, the duration set in the Program Monitor differs from the 
duration chosen in the Program Monitor or Timeline panel. The option at this 
point is to choose to ignore one of the marks.

There is a reason to choose a four-point edit, and it is “fit to fill.” In this case, a 
specific portion of a clip is to be used. The intention is that the chosen frames fill a 
specified destination. To achieve this, the speed of the clip must change, which is 
often the desired effect.
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Retiming clips
There are three additional ways to change the speed of a clip. The use of each dif-
fers as does the reason for choosing a method.

•	 Changing the speed/duration of a clip: This command is useful if you need to 
enter a specific duration or a specific speed change numerically. It also makes 
it easy to reverse a clip. You’ll find advanced controls to specify what happens 
to footage after the selected clip in the Timeline (whether it moves or stays in 
place) to accommodate the speed change.

•	 Changing the speed and duration with the Rate Stretch tool: The Rate 
Stretch tool is a useful way to drag a clip to a specific duration. It respects any 
In and Out points already added but lets you retime a clip by simply dragging.

•	 Changing the speed and duration with time remapping: If you’d like to 
change the speed of a clip so it varies over time, the use of keyframes and 
ramping allows for some very complex rate changes with acceleration or 
deceleration.

Replacing clips and footage
There are three different ways to replace a clip in Adobe Premiere Pro. The method 
chosen will depend upon the complexity of the edit and the global nature of the 
replacement.

•	 Dragging in a replacement clip: If you just want to swap one shot for another, 
simply drag a shot into the Timeline over the desired clip you want to replace. 
Then before releasing the mouse, hold down the Alt (Windows) or Option 
(Mac) key.

•	 Making a replace edit: If the edit is complex, using the Replace Edit command 
allows for positioning the replacement shot and even matching action or dialog. 
This technique is driven by the position of the playhead.

•	 Using the Replace Footage feature: If a clip becomes outdated (such as a 
revised graphic) or is a genuine replacement (a new stock footage shot to 
replace a watermarked version), then this is the best method. Just select the old 
clip in the Project panel and choose Clip > Replace Footage. A dialog box opens 
so the editor can navigate to the replacement footage.

Nesting sequences
Nested sequences have many potential uses.

•	 They simplify editing by creating complex sequences separately. This helps you 
avoid running into conflicts and inadvertently shifting clips on a track that is far 
from your current Work Area.
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•	 They allow you to apply a motion effect to a group of clips.

•	 They let you reuse sequences as a source in multiple sequences.

•	 They organize your work in the same way you might create subfolders in the 
Project panel.

•	 They allow you to transition to a composited group of clips as a single item.

•	 Note that you can use an adjustment layer to apply an effect to a range of clips 
without needing to nest them.

Regular trimming
Most students find the concept of regular trimming pretty easy to understand. They 
can adjust the duration of a clip in the Source Monitor. Additionally, they can trim 
within a sequence to make a selected clip longer by simply dragging. Both methods 
are straightforward and are often used to adjust a clip that does not have adjoining 
media next to the side being trimmed.

Advanced trimming
Adobe Premiere Pro offers standard advanced trimming tools that will be familiar 
to editors with experience on other editing platforms. For a new editor, these tools 
are a bit hard to grasp. Be sure to repeat the demos a few times and emphasize that 
these tools perform a change in much fewer clicks than other methods.

•	 Ripple edit: When you use the Ripple Edit tool to lengthen or shorten a clip, 
your action ripples through the sequence. That is, all clips after that edit slide to 
the left to fill the gap or slide to the right to accommodate a longer clip.

•	 Rolling edit: With a rolling edit, the overall length of the project does not 
change. Instead, a rolling edit takes place at an edit point between two clips, 
shortening one and lengthening the other proportionately. It edits two adjacent 
clips at the same time. A roll edit trims adjacent In and Out points and 
simultaneously adjusts them by the same number of frames.

•	 Sliding edits: The Slide Edit tool works by leaving the duration of the clip 
you’re sliding the same. What changes is that the Out point of the clip to the left 
and the In point of the clip to the right are modified an equal number of frames. 
Essentially you slide the clip forward or back in the Timeline and change the 
content of the shots adjacent to it.

•	 Slip edits: When you slip an edit, you change what portion of the shot is seen. 
A slip edit changes a clip’s In and Out points forward or backward by the same 
number of frames. Using the Slip tool lets you change a clip’s starting and ending 
frames without changing its duration or affecting adjacent clips. This changes 
what part of the shot is visible. The length of the sequence does not change.
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Trimming in the Program Monitor panel
One of the easiest ways to trim is in the Program Monitor panel (just double-click 
an edit point). This method offers much greater control over trimming than other 
methods (as well as visual feedback). This approach allows you to see both the out-
going and incoming frames of the trim you’re working on.

Review questions

Q	 When performing ripple, roll, slip, and slide edits, which edits will affect the 
length of your program?

A	 The ripple edit changes the duration of the clip affected, shortening or 
lengthening the duration of your program. Roll edits affect only the Out point 
of the first clip and the In point of the following clip. Slip edits just modify the 
In and Out points of a clip without affecting its duration. The slide edit just 
moves a clip farther up or down the Timeline, affecting only the Out point of 
the previous clip and the In point of the following clip.

Q	 What is the primary difference between the Replace Clip and Replace Footage 
commands?

A	 Replacing a clip allows you to swap out a clip in the sequence with a clip in 
the Project panel—for example, replacing a clip with an alternate take or shot. 
The duration of the clip in the sequence does not change. Replacing footage 
swaps out media in the Project panel with different footage or perhaps the same 
footage that has been captured at a different resolution or codec.

Q	 What must be done when using Speed/Duration adjustments to not affect the 
length of the Timeline?

A	 Make sure the Ripple Edit, Shifting Trailing Clips option is deselected.

Q	 If you want to change the speed of the clip independently of how it affects the 
audio, what could you do?

A	 Select the Maintain Audio Pitch adjustment when changing the speed/duration.

Q	 What does deselecting the link icon do in the Speed/Duration box?
A	 It permits the change of a clip’s speed without changing its duration on the 

Timeline. You can also adjust both properties independently of each other.

Q	 Where can time remapping be done?
A	 Time remapping can be done in the Effects panel as an intrinsic effect or in the 

Timeline by setting the keyframe bar to show Time Remapping.
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Q	 How is a speed transition created?
A	 A speed keyframe is created either in the Time Remapping section of the Effect 

Controls panel or in the Timeline. Each keyframe is technically two keyframes—
one before the change and one after. (It appears on the Timeline as a rectangle 
with a “split” triangular-shaped tip.) By stretching the two keyframes apart at 
this split, a speed transition is created. A Bezier handle is also created to finesse 
the rate of change.

Module 9: Putting Clips in Motion
•	 This module uses Lesson 9 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.

One of the first effects your students should master is the Motion effect. It is con-
sidered a fixed effect because it is automatically attached to any clip that is added 
to a Timeline. It is useful for animating a graphic or for sizing and repositioning 
a video clip within the frame. This lesson is also an easy chance to show students 
how keyframes behave.

Getting started (p. 202)

Adjusting the Motion effect (p. 202)

•	 Understanding Motion settings (p. 203)

•	 Examining Motion properties (p. 206)

Changing clip position, size, and rotation (p. 208)

•	 Changing Position (p. 208)

•	 Reusing Motion settings (p. 210)

•	 Adding rotation and changing the anchor point (p. 211)

•	 Changing size (p. 214)

Temporal vs. spatial interpolation (p. 216)

Working with keyframe interpolation (p. 216)

•	 Keyframe interpolation methods (p. 217)

•	 Adding Ease to Motion (p. 218)

Using other motion-related effects (p. 220)

•	 Adding a drop shadow (p. 220)

•	 Adding a bevel (p. 221)

•	 Transform (p. 223)

•	 Basic 3D (p. 224)
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Goals and objectives for this lesson
In this lesson, students will get a lot of hands-on practice with the Motion effect 
and its many properties. They’ll learn how to change the scale and rotation prop-
erties as well as refine a clip’s motion path by adjusting its anchor point. Using 
keyframes, they’ll create animated motion and then refine that animation using 
keyframe interpolation. They will also get exposed to a few additional effects such 
as a drop shadow and a beveled edge.

Adjusting the Motion effect
Every clip in the Timeline panel already has the Motion effect applied. This makes 
it an excellent effect to master since you’ll encounter it on every shot. To control 
the effect, an editor will use the Effect Controls panel. Within the panel, you’ll find 
the Motion effect properties (just click the triangle next to the Motion effect name). 
This gives control over the position, scale, or rotation of a clip.

Changing clip position, size, and rotation
The easiest way to learn something is to do it. In this lesson, the student will build 
a simple bumper segment for the behind-the-scenes features of a DVD. To do this, 
they will animate the position of several video clips to create a video wall. They’ll 
then reuse the effect across multiple clips. Next they will animate a title so it scales 
and rotates to build visual interest in the piece. They’ll also learn about opacity and 
blending modes to experiment with mixing items together for basic compositing.

Working with keyframe interpolation
Keyframe interpolation controls the movement between keyframes. For example, 
there is a great difference in how a race car leaves a starting line and a bullet fired 
from a gun. One has a ramping acceleration, while the other is near instant.

There are two categories of interpolation:

•	 Temporal interpolation: Temporal interpolation deals with changes in time. 
It’s an effective way to determine the speed at which an object moves across 
a motion path. For example, you can add acceleration and deceleration to a 
motion path with Ease or Bezier keyframes.

•	 Spatial interpolation: The spatial method commonly deals with changes in 
an object’s shape. It’s an effective way to control the shape of the motion path. 
For example, does an object create hard angular ricochets as it moves from 
keyframe to keyframe, or does the object have a more sloping movement with 
round corners?
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There are also multiple methods of interpolation you can choose that affect both 
the shape and the behavior of a keyframe.

•	 Linear interpolation: The default method of keyframe interpolation is Linear. 
This method creates a uniform rate of change between keyframes.

•	 Bezier interpolation: If you want the most control over keyframe interpolation, 
choose the Bezier interpolation method. This option provides manual controls 
so you can adjust the shape of the value graph or motion path segments on both 
sides of the keyframe.

•	 Auto Bezier interpolation: The Auto Bezier option attempts to create a 
smooth rate of change through a keyframe and will automatically update as you 
change values. This option works best for spatial keyframes that define position 
but can be used for other values as well.

•	 Continuous Bezier interpolation: This option is similar to the Auto Bezier 
option, but it provides some manual controls. The motion or value path will 
have smooth transitions, but you can adjust the shape of the Bezier curve on 
both sides of the keyframe with a control handle.

•	 Hold interpolation: The Hold style is an additional interpolation method that 
is available only for temporal (time-based) properties. This style of keyframe 
allows a keyframe to hold its value across time without a gradual transition. 
This is useful if you want to create staccato-type movements or make an object 
suddenly disappear.

Using other motion-related effects
While the Motion effect is very versatile, you may find yourself needing to enhance 
it further. You can increase perspective by using effects such as a drop shadow or 
a bevel. Additionally, you can add controls for movement using the Transform or 
Basic 3D effect, which introduce movement along the z-axis as well as add some 
perspective and lighting highlights.

Review questions

Q	 How can you reset a clip to its default motion settings?
A	 In the Effect Control panel is a small counterclockwise-facing arrow next to 

each major parameter. Clicking this arrow will reset the parameter to its default.

Q	 How do you add a keyframe to a motion parameter?
A	 In the Effect Control panel, click the small stopwatch next to the name of the 

parameter.
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Q	 How can you crop a video clip?
A	 To crop a clip, you need to place a Crop effect on the clip and crop using the 

parameter controls for that effect. This gives you much greater flexibly when 
combining a cropped clip with other effects.

Q	 How would you apply a drop shadow to a clip?
A	 The drop shadow effect needs to be added to a clip from the Effects panel.

Q	 Which Motion parameter will move a clip in the frame?
A	 The Motion parameter lets you set a new position for a clip. If keyframes are 

used, the effect can be animated.

Q	 You want a clip to appear full-screen for a few seconds and then spin away. How 
do you make the Motion effect’s Rotation feature start within a clip rather than 
at the beginning?

A	 Position the playhead where you want the rotation to begin, and click the Add/
Remove Keyframe button. Then move to where you want the spinning to end, 
and change the Rotation parameter; another keyframe will appear.

Q	 How can you start an object rotating gradually and have it stop rotating slowly?
A	 Use the Ease Out and Ease In parameters to change the keyframe interpolation 

to be gradual rather than sudden.

Q	 If you want to add a drop shadow to a clip, why do you need to use some other 
motion-related effect besides the Motion fixed effect?

A	 The Motion fixed effect is the last effect applied to a clip. Motion takes whatever 
effects you apply before it (including Drop Shadow) and spins the entire 
assemblage as a single unit. To create a realistic drop shadow on a spinning 
object, use Transform or Basic 3D, and then place a drop shadow below one of 
those effects in the Effect Controls panel.

Module 10: Multicamera Editing
•	 This module uses Lesson10 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.

In this lesson, students learn how to cut multiple angles of footage together that 
were shot simultaneously. This type of production is becoming increasingly popular 
as the costs of cameras fall and is known for saving a lot of time during the edito-
rial stage of a project (because it’s easier to avoid continuity errors and jump cuts). 
Adobe Premiere Pro CC makes it possible to cut seamlessly from one angle to 
another. The Adobe Premiere Pro multi-camera editing feature is a tremendous 
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time-saver when you’re editing footage from a shoot or event captured with mul-
tiple cameras.

Getting started (p. 230)

The multicamera process (p. 231)

Creating a multicamera sequence (p. 231)

•	 Determining the sync points (p. 232)

•	 Add clips to a multicamera source sequence (p. 233)

•	 Create the multicamera target sequence (p. 235)

Switching multiple cameras (p. 235)

•	 Enable recording (p. 235)

•	 Re-record multicamera edits (p. 237)

Finalizing multicamera editing (p. 238)

•	 Switching an angle (p. 238)

•	 Flattening a multicamera edit (p. 239)

Sidebars for discussion as time allows

•	 Who uses multicamera editing? (p. 230)

Goals and objectives for this lesson
In this lesson, students will learn how to organize their multi-camera footage, 
including the first step, which is syncing. This can be done using markers, In points, 
Out points, or timecode. They’ll then create a multi-camera source sequence to 
hold the clips and then add that sequence to another for editing purposes. They’ll 
then switch between multiple cameras and record a multi-camera edit. Once fin-
ished, they’ll refine the edit in order to finish it.

The multicamera process
While every project is at least somewhat unique, the multicamera editing process 
has a very standardized workflow. It is essential that students understand how 
choices made during production will impact post-production (such as using a slate 
or sync sources or matching timecode). Once you have your footage shot, there are 
really only six stages to complete.

1	 Load your footage: To edit your footage, you need to load it into Adobe 
Premiere Pro. Ideally, the cameras will be closely matched in frame rate and 
frame size, but you can mix and match if needed.

2	 Determine your sync points: The goal is to keep the multiple angles running 
in sync with each other so you can seamlessly switch between them. You will 
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need to identify a point in time that exists in all angles to synchronize or use 
matching timecode.

3	 Create a multicamera source sequence: The angles must be added to a 
specialized sequence type called a multicamera source sequence. This is 
essentially a specialized clip that contains multiple video angles.

4	 Create the multicamera target sequence: The multicamera source sequence 
is added to a new sequence for editing. This new sequence is the multicamera 
target sequence.

5	 Record the multicamera edits: A special panel, the Multi-Camera Monitor lets 
you switch between camera angles.

6	 Adjust and refine edits: Once the edit is roughed out, you can refine the 
sequence with standard editing and trim commands.

Creating a multicamera sequence
The next step in multicamera editing is to determine a common sync point across all 
angles. You can select from four methods to use for the sync references. The method 
you choose is a matter of personal choice as well as how the footage was shot.

•	 Timecode: Many professional cameras allow the timecode to be synchronized 
across multiple cameras. This can be performed by connecting multiple 
cameras to a common sync source.

•	 In points: If you have a common starting point, you can set an In point on all 
clips you want to use. This method is effective as long as all cameras are rolling 
before the critical action starts.

•	 Out points: This method is similar to syncing with an In point but instead uses 
a common Out point. Out point syncing is ideal when all cameras capture the 
ending of a critical action (such as crossing the finish line) but the cameras were 
started at different times.

•	 Clip markers: In and Out points can be accidentally removed from a clip. 
If you’d like to mark a clip in a more robust fashion, you can use a marker 
to identify a common sync point. Markers are more difficult to accidentally 
remove from a clip.

•	 Audio: If each angle has clean audio recorded from the scene, this can be used 
to synchronize the angles.  This is a new addition to Adobe Premiere Pro CC.

Switching multiple cameras
The Multi-Camera Monitor panel is pretty easy to use (be sure to also show the 
keyboard shortcuts 1–9 to switch angles). Encourage students to also watch the 
footage through once before they attempt to edit it to get familiar with it before 
they try to create a finished cut.
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Finalizing multicamera editing
Once the editor has performed a multicamera edit in the Multi-Camera Monitor, 
they can refine it and then finalize. The resulting sequence is like any other they 
have built. This is a good time to get additional practice using the trimming tools. 
Also, show how an angle can be easily swapped for another by clicking in the 
Multi-Camera Monitor.

Review questions

Q	 Name a method to sync multiple angles.
A	 The following methods all work: Timecode, In points, Out points, and clip 

markers.

Q	 Which audio track is used in a multicamera edit?
A	 The first one you selected.

Q	 How can you move the edit point after you’ve created a multicamera edit while 
maintaining sync?

A	 Use the Roll Edit, Trim In, or Trim Out tool.

Q	 Identify two ways to have the multicamera source and multicamera target 
sequences match settings.

A	 You can either right-click the multicamera source sequence and choose New 
Sequence from Clip or drag the multicamera source sequence into an empty 
sequence and let it autoconform the settings.

Q	 Name two ways to switch between angles in the Multi-Camera Monitor.
A	 To switch angles, you can either click the preview angle in the monitor or use 

the corresponding shortcut key (1–9) for each angle.

Q	 How can you modify an angle after closing the Multi-Camera Monitor?
A	 You can use any of the standard trimming tools in the Timeline to adjust the 

edit points for an angle. If you want to swap the angle, right-click it in the 
Timeline, choose Multi-Camera from the context menu, and choose the camera 
angle you want to use.

Module 11: Editing and Mixing Audio
•	 This module uses Lesson11 in Adobe Premiere Pro CSC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.
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•	 Please note, certain sections of the book have been dropped to conserve time. 
Please teach only the headings listed here.

Adobe Premiere Pro has some of the most advanced audio tools available in a 
nonlinear editing system. For many students, audio is a secondary topic—audio 
somehow goes with the pictures, and music is nice if you can get it.

Of course, the truth is that good-quality audio can make the difference between a 
mediocre film and a powerful, moving story. In many ways, you’ll need your stu-
dents to begin thinking in different ways when starting this lesson, because they’ll 
be using a different part of their brains!

Adobe Premiere Pro CC has enhanced audio features that include a new Audio 
Clip Mixer.

Getting started (p. 244)

Setting up the interface to work with audio (p. 245)

•	 The Audio workspace (p. 245)

•	 Master track output (p. 246)

•	 Audio meters (p. 247)

•	 Viewing samples (p. 248)

•	 Showing audio waveforms (p. 249)

•	 Monitoring audio (p. 250)

Examining audio characteristics (p. 252)

Adjusting audio volume (p. 252)

•	 Adjusting audio in the Effect Controls panel (p. 252)

•	 Adjusting audio gain (p. 254)

Normalizing audio (p. 254)

Creating a split edit (p. 257)

•	 Adding a J-cut (p. 257)

•	 Adding an L-cut (p. 257)

Adjusting audio levels in a sequence (p. 258)

•	 Adjusting overall clip levels (p. 258)

•	 Keyframing volume changes (p. 258)

•	 Smoothing volume between keyframes (p. 258)

Working with the Audio Clip Mixer (p. 261)

•	 Overview of the Audio Track Mixer (p. 262)

•	 Understanding automation modes (p. 263)
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Sidebars for discussion as time allows

•	 What is an audio channel? (p. 247)

•	 About audio level (p. 248)

•	 What are audio characteristics? (p. 251)

•	 Gain and volume— what’s the difference? (p. 254)

•	 Sending audio to Adobe Audition CC (p. 255)

•	 What is a submix? (p. 265)

•	 Producing a 5.1 mix with Adobe Audition (p. 264)

Goals and objectives for this lesson
This lesson introduces the audio tools in much more detail, building familiar-
ity with the tools and an understanding of the workflows. Students will learn the 
meanings of some audio terminology and get their first introduction to keyframing.

Using keyframes to adjust audio is an excellent way to discover this important 
feature of nonlinear editing. Many students struggle to register the way the Audio 
Mixer exclusively works on tracks, while the Effect Controls panel exclusively 
works on clips. This is something you may want to remind them of regularly to save 
them from struggling with the interface.

The introduction of the new Audio Clip Mixer may make it easier for the class to 
differentiate between the two, simply because one mixer has “Clip” in the name, 
and the other has “Track” in the name.

Setting up the interface to work with audio
By now, your students should be quite comfortable with switching between work-
spaces. It may be worth noting that the audio meters are not included in the default 
Audio workspace, because each track and the master in the Audio Mixer already 
has an audio meter built in.

This section describes the various options for sequence master track output. While 
most edits ultimately produce a stereo master, this is an excellent opportunity to 
break down what it means to speak of “left” and “right.” These are really Channel 1 
and Channel 2, with a universal agreement that, by default, these channels will be 
played through speakers positioned on the left and right.

Examining audio characteristics
This is an important opportunity to confirm everyone has the same core under-
standing of audio. It’s common for media practitioners to lack some of the most 
fundamental training in audio and video capture and presentation. By discussing 
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the three factors of Frequency, Amplitude, and Phase, you can create a reference 
point for many of the topics later in the class.

There is limited control over Phase in Adobe Premiere Pro and it can be difficult for 
some students to understand without a practical demonstration. It might be easier 
to place more emphasis on Frequency and Amplitude. 

Adjusting audio volume
Adobe Premiere Pro offers multiple ways to adjust the playback volume of clips. It’s 
helpful to think of the volume adjustments as a kind of chain, in this order:

1	 Clip gain

2	 The Effect Controls panel (or using the clip rubber band control in the Timeline 
panel)

3	 Track volume (including track-based rubber banding and Audio Mixer controls)

4	 The Master volume

This section introduces audio adjustments using the Effect Controls panel and 
overall clip gain, which is a good starting point for understanding the way volume 
adjustments affect playback.

This is also a good opportunity to remind students that Adobe Premiere Pro is 
completely nondestructive, so even the clip gain adjustments will not change the 
original media files.

Creating a split edit
While most of this course is dedicated to understanding the controls and the tech-
nology, rather than the art of editing, this section is an opportunity to show the way 
mixing audio and video from difference scenes can make a great difference to the 
audience experience.

Having shown your students how to create a split edit, you may want to show them 
a similar result by placing audio on different tracks. Though this requires more 
mouse clicks, it will usually give easier creative control.

Adjusting audio levels for a clip
The Audio Clip Mixer and Audio Track Mixer have a markedly different interface 
design from the rest of Adobe Premiere Pro. This is partly out of necessity, because 
a lot of controls need to be packed into a small space.

The Audio Track Mixer also has features that don’t appear in other parts of the 
application, such as track-based effects and sends. Students usually understand 
track-based effects well—they are, after all, just an extension of the kinds of effects 
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they have been working with already. However, many students will only fully 
understand sends if you give them a specific demonstration.

Consider creating a sequence with multiple audio tracks and creating a submix. 
Rather than using prefader sends, try setting the output from the audio tracks to go 
through the submix you created, and add an obvious special effect—something like 
a delay is a good example.

Show the results of passing the audio outputs through the submix, and then explain 
the alternative—using sends that are prefader, allowing you to create a “wet” and 
“dry” mix. If you have time, you could create a second submix with no effects and 
set the output from the audio tracks to that submix. This way, one submix will be 
clean, with no effects, and the other will have an obvious effect, allowing you to 
use just two fader controls to adjust the overall mix of audio with effects and audio 
without effects.

Review questions

Q	 How do you smooth out the transitions between keyframes?
A	 By right-clicking an existing keyframe, you can choose from several options, 

including Ease In, Ease Out, and Auto Bezier for an Ease In/Out.

Q	 How does normalization differ from just raising the volume?
A	 Normalization raises the highest peak moment in a clip to a set level. Raising 

the volume just increases the loudness relative to its current level.

Q	 What’s the difference between Normalize Max Peaks and Normalize All Peaks?
A	 When applied to multiple clips simultaneously, Normalize Max Peaks finds 

the maximum peak across all the clips and adjusts all the clips relative to that 
maximum. Normalize All Peaks considers each clip individually.

Q	 How can you move the current-time indicator by a single audio sample?
A	 Load the audio into the Source Monitor and choose Show Audio Time units 

from the Source panel menu. By making this selection, Adobe Premiere Pro 
allows you to edit to the millisecond versus to the frame.

Q	 What modifier key should you use in combination with the Selection tool to add 
a keyframe to a rubber band in the Timeline panel?

A	 The Control key (Windows) or Command key (Mac).

Q	 Which is applied first, clip volume adjustments or track volume adjustments?
A	 Clip volume adjustments are applied before track volume adjustments.
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Q	 If you switch to the Audio workspace, the audio meters are not displayed by 
default. How would you display them?

A	 Go to the Window menu, and choose Audio Meters.

Q	 What will happen if you use the Audio Track Mixer to set a track’s automation 
mode to Off?

A	 When a track’s automation is off, track-based keyframes will no longer control 
the track fader and therefore will no longer affect the track volume.

Q	 When recording stereo audio, which channel is normally used for left, and 
which is normally used for right?

A	 Channel 1 is the standard Left channel, while Channel 2 is the standard Right 
channel.

Q	 If your master audio level peaks, the audio meters will show red indicators at 
the top. How can you reset them?

A	 Click the red indicators, or right-click the audio meters and choose Reset 
Indicators.

Module 12: Sweetening Sound
•	 This module uses Lesson12 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.

The goal in this lesson is to improve the overall quality of audio in video projects. 
Several effects can be used to do this. Effects can be applied to individual clips or 
even a whole track. In this lesson, students will learn specific filters to repair com-
mon issues.

Getting started (p. 268)

Sweetening sound with audio effects (p. 269)

•	 Adjusting bass (p. 269)

•	 Adding a delay (p. 270)

•	 Adjusting pitch (p. 271)

•	 Adjusting treble (p. 272)

•	 Adding reverb (p. 272)

Adjusting EQ (p. 274)

•	 Standard EQ (p. 274)

•	 Parametric EQ (p. 276)

Applying effects in the Audio Track Mixer (p. 277)



50  INSTRUCTOR NOTES

•	 Creating an initial mix (p. 278)

•	 Creating a submix (p. 280)

•	 Applying effects to a submix (p. 282)

Audio Plug-in Manager (p. 284)

Cleaning up noisy audio (p. 286)

•	 Highpass and Lowpass effects (p. 286)

•	 Multiband Compressor (p. 286)

•	 Notch effect (p. 289)

•	 Dynamics (p. 289)

Sidebars for discussion as time allows

•	 Removing background noise with Adobe Audition (p. 292)

Goals and objectives for this lesson
This lesson is fairly comprehensive because it explores several options for modify-
ing the audio in a project. Students learn to use effects to manipulate the high, low, 
and middle frequencies, as well as EQ to affect multiple frequencies at once. In this 
lesson, they learn to also apply effects to a clip or an entire track as well as how to 
remove background noise from a clip.

Sweetening sound with audio effects
To hear these subtle adjustments, ensure that students are wearing their head-
phones. It is also a good idea to toggle an effect on and off to hear the before and 
after states. Your students will adjust the bass for a male announcer, add a stylized 
delay with a slight echo, and adjust the pitch to change the energy level. They’ll also 
modify higher frequencies using treble and add reverb to enhance a musical track.

Adjusting EQ
Several frequencies can be modified at once using an EQ effect. The standard EQ 
effect in Adobe Premiere Pro offers five bands of control. Individual frequencies 
can be adjusted using the Parametric EQ effect. This effect can also be combined to 
create a complex multiband effect.

Applying effects in the Audio Mixer
One of the more unique aspects of Adobe Premiere Pro is how you can also apply 
effects to an entire track. This is useful for enhancing a narration track or for creat-
ing a complex audio mix for a multitrack musical bed. Students will learn about 



ADOBE PREMIERE PRO CC CLASSROOM IN A BOOK  51

creating submixes as well as how to modify and enhance individual components of 
a mix.

Cleaning up noisy audio
The problem of background noise is a fairly common occurrence. In this lesson, 
students will remove a variety of problems caused by poor microphones and exter-
nal conditions. The Highpass and Lowpass effects can be used to define a threshold 
for audio. The Notch effect can also be used to target a specific problem area. The 
Dynamics plug-in can enhance a clip in several ways at once and works very well 
for removing problem audio in a clip.

Review questions

Q	 Which application in the Adobe digital video lineup can you use for advanced 
audio repair?

A	 Adobe Audition offers greater functionality (including a multi-track mixer) and 
advanced restoration tools.

Q	 Which button should you click in the Audio Mixer or Timeline panel to hear 
only one audio track on a Timeline?

A	 The Solo button allows you to isolate and listen to just one track when playing 
out from the Timeline.

Q	 When using automation with the Audio Mixer, where do the keyframes appear?
A	 They become track keyframes.

Q	 What are the different of methods of automation for the Audio Mixer?
A	 There are several modes to choose from:

Off: Permits experimentation without recording adjustments

Read: Allows you to read existing adjustments (the default will adjust the entire 
track)

Write: Writes any adjustments you make as you listen

Latch: Is identical to Write but won’t apply changes until you move the sliders 
(and it is usually used after Write)

Touch: Is similar to Latch in that it is used after an initial set of keyframes but 
snaps back to the prior recording levels when the slider is released

Q	 To change the apparent speed of an audio clip without changing its duration, 
which effect would you use?

A	 The PitchShifter effect can modify the apparent pitch or energy level for a clip 
while still maintaining sync with a video clip.
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Q	 What’s the difference between the Delay and Reverb effects?
A	 Delay creates a distinct, single echo that can repeat and gradually fade. Reverb 

creates a mix of echoes to simulate a room. It has multiple parameters that take 
the hard edge off the echo you hear in the Delay effect.

Q	 How do you apply the same audio effect with the same parameters to three 
audio tracks?

A	 The easiest way to create a submix track is to assign those three tracks to that 
submix track and apply the effect to the submix.

Q	 Name three ways to remove background noise from a clip.
A	 You can use a Notch or Dynamics effect within Adobe Premiere Pro or send the 

clip to Adobe Audition to use its advanced noise reduction controls.

Module 13: Adding Video Effects
•	 This module uses Lesson 13 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.

Adobe Premiere Pro CC features more than 100 video effects. Students typically 
enjoy working with effects and like to experiment with processing their images. 
Most effects come with an array of parameters, all of which can be animated by 
using precise keyframe controls. They key with effects is to ensure that students 
master using restraint and learn to match an effect to an issue or an outcome.

Getting started (p. 298)

Working with effects (p. 298)

•	 Fixed effects (p. 299)

•	 The Effects Browser (p. 301)

•	 Accelerated effects (p. 303)

•	 32-bit color (high-bit-depth) effects (p. 304)

•	 YUV effects (p.304)

•	 Applying effects (p. 305)

•	 Other ways to apply effects (p. 307)

•	 Using adjustment layers (p. 307)

•	 Sending a clip to Adobe After Effects (p. 311)
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Keyframing effects (p. 314)

•	 Adding keyframes (p. 314)

•	 Adding keyframe interpolation and velocity (p. 315)

Effects presets (p. 318)

•	 Using built-in presets (p. 318)

•	 Saving effects presets (p. 319)

Frequently used effects (p. 321)

•	 Image stabilization and rolling shutter reduction (p. 321)

•	 Timecode burn-in and Clip Name (p. 323)

•	 Shadow/Highlight (p. 325)

Goals and objectives for this lesson
During this lesson, students will continue to work with fixed effects as well as add 
custom effects using the Effects Browser. Besides applying effects, they’ll learn to 
customize the effect and even keyframe changes over time. These customizations 
can be saved as presets for easy reuse. Additionally, the student will try some real-
world effects.

Working with effects
Students who’ve used another editing application may spend some time hunting 
for an Effects menu. It’s important to show them both fixed effects (automatically 
applied for Motion, Opacity, and Time Remapping) as well as the Effects Browser. 
Pay particular attention to teaching the use of icons for accelerated effects, 32-bit 
color, and YUV effects because these will greatly impact workflow. Adjustment lay-
ers should be carefully explored because they offer a lot of speed benefits.

Keyframing effects
If the order of lessons has been followed, the use of keyframes should be an easy 
refresher. The goal here is to teach students how to change an effect over time. 
Additionally, the use of keyframe interpolation can make an effect appear more 
natural.

Effects presets
The use of presets has two major purposes. First, the built-in presets help a user 
quickly explore how effects can be used. More importantly, the ability for an editor 
to create their own presets can be a huge time-saver. The challenge is that presets 
cannot be easily moved from one computer to another.
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Frequently used effects
Your students should enjoy exploring the practical application of effects. The first 
exercise explores stabilizing shaky footage (a common problem). Next students will 
add a timecode window to a review copy for output to allow for accurate feedback. 
Finally, the Shadow/Highlight effect is explored to digitally relight a scene.

Review questions

Q	 How do you apply an effect to a clip or to a group of clips?
A	 Drag the effect from the Effects panel directly onto the clip or a selected series 

of clips in the Timeline.

Q	 Can you change the order of effects after you have applied them to a clip?
A	 Yes, simply grab the effect by its name (a hand appears), and drag it into the 

order you want it to occur.

Q	 How do you remove an effect?
A	 To remove an effect, you can simply select it in the Effects Control panel and 

press Delete.

Q	 Can you save an effect that you created for later use?
A	 Yes, simply right-click the effect in the Source Monitor and choose Save Preset.

Q	 How can you apply multiple effects from one clip to another clip or clips?
A	 Select the effects you want to apply in the Effects panel. Right-click and choose 

Copy. Select the clip or clips you want to apply the effects to in your Timeline, 
right-click, and then select Paste Attributes.

Q	 What is one advantage of a nested sequence when working with effects?
A	 A nested sequence allows you to apply a single effect or multiple effects to a 

group of clips and control the parameters of those effects on the entire group 
simultaneously. Alternatively, you can use an adjustment layer to affect a range 
of multiple clips.

Module 14: Color Correction and Grading
•	 This module uses Lesson 14 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.

•	 Please note, certain sections of the book have been dropped to conserve time. 
Please teach only the headings listed here.
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Color correction can be as simple as making sure white paper looks white or as 
advanced and complex as creating a multilayered special effects look for your shots 
that picks out individual colors, uses secondary color correction, and blends mul-
tiple clips into a complete composition.

For your students, this lesson represents a fun opportunity to expand their skills 
to include exciting special effects and to learn how to use some universally useful 
technologies—in particular, the Vectorscope and waveforms.

Getting started (p. 330)

Color-oriented workflow (p. 331)

•	 The Color Correction workspace (p. 332)

•	 Video scope essentials (p. 333)

•	 The Reference Monitor (p. 334)

An overview of color-oriented effects (p. 342) [Short Demo—Hands Off]

•	 Coloring effects (p. 342)

•	 Color removal or replacement (p. 343)

•	 Color Correction (p. 344)

•	 Technical color effects (p. 346)

Fixing exposure problems (p. 347)

•	 Underexposed images (p. 348)

•	 Overexposed images (p. 349)

Fixing color balance (p. 349)

•	 Basic white balance (Fast Color Corrector) (p. 350)

•	 Primary color correction (p. 351)

•	 Secondary color correction (p. 354)

Special color effects (p. 356)

•	 The Leave Color effect (p. 356)

•	 The Change to Color effect (p. 357)

•	 Broadcast legalization (p. 358)

Creating a look (p. 358)

Sidebars for discussion as time allows

•	 About primary and secondary colors (p. 338)

•	 Additive and subtractive color (p. 339)

•	 Using Lumetri effects and SpeedGrade (p. 346)
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•	 When is color correction right? (p. 349)

•	 About levels (p. 352)

•	 Sending clips to Adobe SpeedGrade (p. 359) [a teaser for SpeedGrade]

Goals and objectives for this lesson
In this lesson, students will learn to read the Vectorscope and Waveform Monitors, 
use the Reference Monitor, discover some of the color correction effects, and work 
with the Three-Way Color Corrector effect, which incorporates many of the main 
controls used by other color-related effects.

This lesson also clarifies the difference between fixed effects and effects available in 
the Effects panel.

Color-oriented workflow
It’s important for your students to understand the limitations when using their 
computer monitor to make subjective assessments of color and luminance. If you 
can set up your classroom to have at least one editing system output to a regular 
television monitor, you can demonstrate the dramatic difference in appearance 
when working with color for different display mediums.

If you drag and drop the current sequence into the Source Monitor, you can 
use it to display a comparison frame, while working on a different clip using the 
Program Monitor, with the Reference Monitor showing either the Vectorscope or a 
waveform.

If you describe the differences between additive and subtractive color, you may 
be giving your students some of the first basic color theory training they have 
received. This is a fascinating subject but can easily end up taking a substantial 
amount of time from the rest of your lesson.

It is possible that learning about the Vectorscope and waveforms will be the first 
time your students have used any professional system of measurement to interpret 
images. It might help them to know that these are the visual equivalent of an audio 
waveform display.

An overview of color-oriented effects
Though the book offers a reasonable summary and screen shot to show off the 
effects in this section, it is an opportunity to get your students into the habit of 
adding, adjusting, and removing effects. Once you unleash access to the Effects 
panel, it is likely you’ll have trouble getting the attention of your class! It’s a good 
opportunity to let your students experiment for a little while and then bring the 
focus back to you so you can summarize the differences between the effects.
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This is also a good opportunity to highlight which effects are CUDA-enabled, 
32-bit, or YUV native.

Importantly, Adobe Premiere Pro now offers support for LUT and .look files, and 
includes a new looks browser in the Effects list. Depending on your class, you may 
want to take the time to explain LUT files and Adobe SpeedGrade integration. In 
particular, it might be valuable to explain where Adobe SpeedGrade fits in the post-
production workflow.

Fixing exposure problems
The main purpose of this section is to introduce Curves. It’s also an excellent 
opportunity for your students to practice using the waveform to interpret images 
and observe the results of changes they make.

Curves is a useful interface control to learn, because it helps explain the way other 
effects work, such as the Brightness and Contrast effect. If you have a whiteboard 
in the classroom, you can draw multiple Curves graphs and draw on the results of 
adjusting contrast, brightness, and gamma.

Fixing color balance
Students learn how to automatically correct poor white balance and then how to 
adjust color wheel controls. Like the Curves controls, the color wheel gives core 
skills and understanding about the way colors are recorded and reproduced.

You may find it helpful to highlight for your students that the way the colors are 
displayed on a color wheel match the markings on the Vectorscope.

The Three-Way Color Corrector effect has a long list of controls, and if too many of 
these controls are new concepts to your students, they are likely to be overloaded 
with information. The challenge is not that any single topic is particularly hard to 
understand. Rather, there are just so many topics your students may need a break 
to assimilate new information part way through the lesson.

You’ll need to assess the class on a case-by-case basis, but consider introducing the 
most important parts of the effect controls and then switching to showing your 
students how to experiment with the controls and judge the results for themselves.

Most of the controls produce dramatic results if you adjust them enough, so 
experimentation might be enough to learn what they do. There are a small number 
of exceptions, such as the Tonal Range Definition control, which is far enough from 
the color wheel controls to seem unrelated. Consider demonstrating this control, 
and the secondary color correction controls in particular, to avoid confusion when 
your students are exploring this effect in their own time.
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Creating a look
Of course, not all color adjustment is intended to make visuals look realistic. This 
section is an excellent opportunity to show how color correction effects can convey 
significance to an audience.

This is also an opportunity for your students to learn about, and practice with, 
adjustment layers. There is a lot you could say about using adjustment layers to 
work with effects, but with limited time, you may want to focus on the key prin-
ciples at work instead.

•	 How to add an adjustment layer

•	 How to add, adjust, and remove effects using an adjustment layer

•	 How to edit, move, and remove an adjustment layer

Review questions

Q	 Describe what video scopes are used for.
A	 Scopes are tools to provide objective measurement of chroma and luminance 

information.

Q	 What does the Broadcast Colors or Video Limiter effect do?
A	 Each conforms the limits of the signal to broadcast standards and limits. The 

Video Limiter has more precise control than the Broadcast Color effect.

Q	 When using the white balance on the Fast Color Corrector or Three-Way Color 
Corrector, what should you be clicking?

A	 A part of the image that should be neutral gray but has a color tint to it—
without any chrominance. This could be a gray card or light gray element in the 
video or a white element that isn’t blown out (windows and skies are not usually 
good examples).

Q	 Which of these effects permits the greatest amount of control over the color 
signal: Auto Color, Fast Color Corrector, or Three-Way Color Corrector?

A	 The Three-Way Color Corrector effect permits the greatest adjustment of 
the video signal with independent controls for the shadows, midtones, and 
highlights.

Q	 Why is it important to have a television screen connected to your editing system 
if you intend to produce video for display on a television?

A	 Computer screens and televisions display color using difference systems. Colors, 
highlights, and shadows can look dramatically different on each kind of display. 
It is important to view colors using the kind of screen your video is intended for.
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Q	 How does the RGB parade fit information for all three color channels into a 
single display?

A	 The full-screen image for each color is compressed horizontally to be able to 
display all three colors side by side.

Q	 What is secondary color correction?
A	 Color adjustment applied to a selected range of pixels, based on their hue, 

saturation, or luminance.

Q	 How can you tell when your color correction is perfect?
A	 Ultimately, color correction is a subjective art. You can use precise 

measurements to make sure technical goals are achieved, such as limiting levels 
or matching one shot to another, but the final measure is whether the result 
matches your vision.

Q	 How do you use a white balance eyedropper?
A	 Make sure the clip you are working on is displayed in the Program Monitor. 

Click the eyedropper to select it, and then click in the Program Monitor on a 
pixel that should be white but isn’t. A color adjustment is applied automatically 
to correct the whole image so that the pixel you clicked becomes white.

Module 15:  
Exploring Compositing Techniques
•	 This module uses Lesson 15 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.

•	 Please note, certain sections of the book have been dropped to conserve time. 
Please teach only the headings listed here.

To understand compositing, your students will need to expand their perspective 
on the way pixel information is stored. Alpha channel is rarely familiar territory 
for new editors. This lesson introduces some of the most powerful and engag-
ing features Adobe Premiere Pro has to offer, and though learning the techniques 
described takes focused concentration and a little time, you’ll likely find your stu-
dents are particularly engaged, because the results are often dramatic.

Though Adobe Premiere Pro is primarily intended for video editing, rather than 
effects work, it includes some excellent tools for fine finishing and compositing. In 
particular, the Ultra Key effect and the ability to work with track matte keys and 
nested sequences give editors a lot of creative freedom.
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Getting started (p. 364)

What is an alpha channel? (p. 364)

Using compositing in your projects (p. 366)

•	 Shooting videos with compositing in mind (p. 366)

•	 Essential terminology (p. 368)

Working with the Opacity effect (p. 368)

•	 Keyframing opacity (p. 369)

•	 Working with alpha-channel transparencies (p. 371)

Color keying a greenscreen shot (p. 372)

•	 Preprocessing the footage (p. 374)

•	 Using the Ultra Key effect (p. 374)

Using mattes (p. 377)

•	 Using mattes that use graphics or other clips (p. 379)

•	 Using Track Matte Key (p. 379)

•	 Creating a custom matte with the Title tool (p. 380)

•	 Making a traveling matte (p. 382)

Sidebars for discussion as time allows

•	 Using the After Effects Roto Brush Tool (p. 384)

Goals and objectives for this lesson
This lesson expands understanding of color channels; it introduces the alpha chan-
nel and blending modes. Students will learn about keying using greenscreen video 
and the Ultra Key effect and the use of garbage mattes and the track matte key.

What is an alpha channel?
This section introduces the concept of an alpha channel. Once students understand 
an alpha channel can be adjusted in the same way as a color channel, they can eas-
ily also understand the way the Opacity effect or a Chromakey effect works.

You may find it helpful to highlight the difference between 50 percent gray pixels 
and white pixels with 50 percent opacity. Against the black background of the 
Timeline, they can have a very similar appearance. Consider setting up two color 
matte clips to demonstrate the difference, edited into a sequence on Video 2, with 
color bars on Video 1 later in the sequence. If you initially show the clips side by 
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side with the same appearance and then move them in front of the color bars, the 
difference will be immediately clear.

Working with the Opacity effect
Showing the results of adjusting opacity will further help your students see the 
direct relationship between alpha channel adjustments and the clip opacity. 
Showing keyframing opacity using clip-based rubber bands helps reinforce the way 
keyframe rubber bands always behave the same way, regardless of the adjustment 
they are applying.

It can be difficult to find ideal clips to demonstrate blending modes. You’ll find 
the Double Identity title works well, because it combines a mixture of colors and 
textures. Images with strong contrast and areas of clear color work well to demon-
strate this feature.

As with many of the effects included with Adobe Premiere Pro, the blending modes 
are often learned best by personal experimentation. Rather than encouraging your 
students to memorize each mode, make sure they know how to apply and remove a 
blending mode so they can explore the effects another time.

Color keying a greenscreen shot
The Ultra Key effect is highly regarded, providing excellent keying, even with 
difficult-to-key source media. It is rarely possible to automatically obtain a perfect 
key, however. You’ll need to give your students a little time as you explain each of 
the controls.

Some of the controls will make good sense, based on earlier lessons. The Contrast 
control, for example, under the Matte Cleanup category of controls, applies a 
simple contrast adjustment to the matte that is generated.

Switch often between the composite and alpha channel output so your students 
can see the results of the adjustments. Often, the initial color selection will look 
good based on a composite image. Switching to the alpha channel will quickly show 
weaknesses in the matte that is being created.

Some of the controls, such as Choke, will be new to your students. You can some-
times explain these controls more easily by showing the key and making dramatic 
adjustments to illustrate the impact they have.

Using mattes
By the time you teach the Garbage Matte effects, your students will have learned 
about multiple ways to change the appearance of video clips and to adjust alpha 
channels. You may find it helpful to take a moment to list the various ways image 
adjustments can be applied and, separately, the various ways selections can be 
made to identify which pixels should be opaque and which should be transparent.
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The Garbage Matte effects provide a relatively simple way to define which pixels 
should 100 percent visible or 0 percent visible. They are often used in combination 
with chromakey effects to remove visual elements that could not be obscured with 
the key color.

It’s important for your students to begin understanding the way effects can be used 
in combination to produce a composite result. In this instance, it’s by combining 
the Ultra Key effect with the Four-Point Garbage Matte, but earlier it was by com-
bining multiple color correction effects.

Combining multiple effects in this way allows for the art and craft of post-produc-
tion fine finishing.

Using Track Matte Key
The Track Matte Key effect is simple to set up—there are very few controls—but 
it allows for some of the most advanced effects workflows. As is often the case for 
specialized effects, the results are often the best if they were planned for during 
production.

The Track Matte Key effect achieves a very similar result to a Garbage Matte effect, 
except that the source of the matte is another clip segment, rather than control 
points in the Program Monitor.

The exercise shows a very common request—hiding or highlighting an individual. 
Though Adobe Premiere Pro has no automated motion tracking, the Track Matte 
Key effect can achieve the desired result. You might want to demonstrate more uses 
of this effect—such as displaying video cut out by the letters of a title. This can be 
fun in the classroom, if your students choose the text.

Review questions

Q	 What should you look out for when shooting keying material with some 
cameras?

A	 Some cameras use heavy compression and then throw away some of the chroma 
subsampling information to reduce file size. Artifacts and limited color data 
may make it difficult to create a clean chromakey.

Q	 Which keying effect is the preferred choice in Adobe Premiere Pro?
A	 The Ultra Key effect.

Q	 Which effects allow you to mask part of the video, essentially removing the 
“garbage”?

A	 The four-point, eight-point, and sixteen-point Garbage Matte effects.
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Q	 How many tracks does the Track Matte effect need? Which track does it get 
applied to?

A	 Typically, three tracks are used:
The bottom track (background).
The middle track (foreground).
The top track (the matte). The effect goes on the top track (the matte), allowing 
it to cut the foreground over the background.

Q	 What information from a matte clip is used for the Track Matte effect?
A	 There are two choices:

Matte Alpha: Composites using the track matte clip’s alpha channel values
Matte Luma: Composites using the track matte clip’s luminance values

Q	 Why is green often used as a background color for chromakey effects?
A	 Any color could be used, but green is particularly distinct from most human 

skin colors.

Q	 When might you combine a chromakey effect with a Garbage Matte or Track 
Matte Key effect?

A	 It is common for the green background used on location to leave gaps that 
cannot be keyed. Combining a chromakey effect with a regular matte effect 
allows you to remove the unwanted parts of the picture.

Q	 If you reduce the opacity of a clip on the Video 1 track in a sequence, why does 
it appear to get darker?

A	 The clip appears to get darker because you are partially revealing the black 
background of the sequence. The more transparent you make the clip, the more 
it is blended with the dark background.

Q	 What are the two ways the Track Matte Key effect can use pixels in one clip to 
define the opacity of pixels in another clip in a sequence?

A	 The Track Matte Key effect can use either the alpha channel or the luminance 
level of pixels in one clip to define the opacity of pixels in another clip.

Q	 How does the Luma Key effect define transparency for a clip?
A	 The Luma Key effect uses the brightness of pixels as a guide for which should be 

transparent and which should be opaque.

Q	 What is the default blending mode?
A	 The default blending mode is Normal. In this mode, foreground pixels do not 

interact with background pixels in any particular way. If you reduce the opacity 
of the foreground clip, the result is a simple blend of the foreground and 
background.
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Module 17: Creating Titles
•	 This module uses Lesson16 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.

While the use of audio and video sources remains as the primary ingredients for 
building a sequence, there is still often a need to incorporate text into a project. 
Text is very effective when information needs to be conveyed quickly to an audi-
ence. Unfortunately, good typography is rarely studied by video professionals, and 
it’s very easy to create text that distracts from the overall goal and lowers the qual-
ity of a sequence.

Getting started (p. 388)

An overview of the Titler window (p. 388)

Video typography essentials (p. 393)

•	 Font choice (p. 393)

•	 Color choice (p. 394)

•	 Kerning (p. 395)

•	 Tracking (p. 396)

•	 Leading (p. 396)

•	 Safe title margin (p. 398)

Creating titles (p. 398)

•	 Adding point text (p. 399)

•	 Adding paragraph text (p. 401)

Stylizing text (p. 403)

•	 Changing a title’s appearance (p. 403)

•	 Saving custom styles (p. 405)

Working with shapes and logos (p. 408)

•	 Creating shapes (p. 408)

•	 Adding a graphic (p. 410)

•	 Aligning shapes and logos (p. 411)

Making text roll and crawl (p. 413)

Sidebars for discussion as time allows

•	 Using titles in other projects (p. 393)

•	 Creating an Adobe Photoshop graphic or title (p. 406)

•	 Animated text with Adobe After Effects (p. 415)
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Goals and objectives for this lesson
The Titler inside Adobe Premiere Pro is very versatile. In this lesson, students will 
learn to identify the major features of the Titler window. They will also get a primer 
on essential typographic principles to use when creating titles and stylizing text.

Additionally, they’ll learn to create shapes and work with logos for more advanced 
designs. They’ll put text into motion by making it roll and crawl as well as explore 
timesaving design approaches such as working with templates.

An overview of the Titler window
The Titler window is broken down into five major areas of functionality.

•	 Title Tools panel: These tools define text boundaries, set text paths, and select 
geometric shapes.

•	 Title Designer panel: This is where you build and view text and graphics.

•	 Title Properties panel: Here you’ll find text and graphic options such as font 
characteristics and effects.

•	 Title Actions panel: You’ll use these to align, center, or distribute text and 
groups of objects.

•	 Title Styles panel: Here you’ll find preset text styles. You can choose from 
several libraries of styles.

Video typography essentials
This is an excellent time to engage the students in a discussion of good typogra-
phy. The book identifies several core concepts that can really be brought to life. 
Consider examining some movie or television credit sequences and discussing best 
practices. Prepare students that many of the templates in Adobe Premiere Pro do 
not feature well-designed type.

Creating titles
There are several ways to create text in the Adobe Premiere Pro Titler. Be sure to 
demonstrate how different tools behave. An important distinction is to closely 
examine the difference between point and paragraph text because it will greatly 
affect areas such as wrapping.

Stylizing text
There are many ways to change a title’s appearance. The key here like many areas 
is restraint. Instead of applying all of the possible options, try using two or three to 
complete a minimalist effect. The available categories include the following:
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•	 Fill Type: You have several choices of fill type. The most popular ones are Solid 
and Linear Gradient, but you will also find additional gradient, bevel, and 
ghosting options.

•	 Color: Set the color for your text. You can click the swatch or enter numerical 
values in the Color Picker or use the Eyedropper tool to sample from your 
video clip.

•	 Sheen: A gentle highlight can add depth to your title. Be sure to adjust the size 
and opacity so the effect is subtle.

•	 Stroke: You can click to add inner and outer strokes. Strokes can be solid or 
gradient and add a thin edge to the outside of the text. Adjust the opacity of a 
gradient to create a gentle glow or soft edge. A stroke is commonly used to help 
keep text legible over a video or complex background.

•	 Shadow: The use of a drop shadow is a common addition to video text because 
it makes the text easier to read. Be sure to adjust the softness of the shadow. 
Also, be sure to keep the angle of shadows identical for all titles in a project for 
design consistency.

Working with shapes and logos
Several shape tools exist in the Adobe Premiere Pro Titler to help design cus-
tom bars or design elements. Additionally, the students will learn how to insert a 
graphic file in (called a logo) to add a design element. Once design elements are 
inserted into a title, they can be aligned or distributed to create a more unified 
layout.

Making text roll and crawl
Occasionally, there will come a need to make text roll or crawl. A roll causes text to 
move vertically (much like standard credits in a movie). A crawl, on the other hand, 
moves text horizontally (much like a stock ticker). Both can be easily done and are 
easy concepts to grasp. Be sure to show advanced options to control timing as well 
as the start and end positions of a title.

Review questions

Q	 What are the different types of text you can create?
A	 There are three kinds of text:

•	 Point text runs in a single line until you press Return.

•	 Paragraph text is based on the bounding box of the initial click and drag.

•	 Text on a path is text that follows a user-created path.
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Q	 How can you get point text to wrap?
A	 Choose Title > Word Wrap.

Q	 How do you create rolling text?
A	 Choose Title > New Title > Default Roll.

Q	 How do you adjust the start and finish position for rolling text?
A	 You can use the Roll/Crawl Timing options.

Q	 How do you give your text an edge?
A	 You add a stroke, either inner or outer, and change it to a different color than 

your text.

Q	 What are the differences between point text and paragraph (or area) text?
A	 You create point text with the Type tool. Its bounding box expands as you type. 

Changing the box shape changes the text size and shape accordingly. When you 
use the Area Type tool, you define a bounding box, and the characters remain 
within its confines. Changing the box’s shape displays more or fewer characters.

Q	 Why display the title-safe zone?
A	 Some TV sets cut off the edges of the TV signal. The amount lost varies from set 

to set. Keeping your text within the title-safe margin ensures that viewers will 
see all your title. This is less of a problem with newer digital TVs, but it is still a 
good idea to use the title-safe zone to frame your titles.

Q	 Why might the align tools be dimmed?
A	 The align tools become active if more than one object is selected in the Titler. 

The Distribute tools also become active when more than two objects are 
selected.

Q	 How do you use the Rectangle tool to make a perfect square?
A	 To create a perfect square, hold down the Shift key as you draw using the 

Rectangle tool.

Q	 How do you apply a stroke or drop shadow?
A	 To apply a stroke or drop shadow, select the text or object to edit, and click its 

Stroke (Outer or Inner) or Shadow box to add a stroke or a drop shadow. Then 
start adjusting parameters, and they will show up on the object.

Module 17: Managing Your Projects
•	 This module uses Lesson 17 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.
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•	 Please note, certain sections of the book have been dropped to conserve time. 
Please teach only the headings listed here.

For very short projects, with relatively little source media, project management may 
not be too important. Even then, if you are working on many different projects, it is 
still necessary to find a way to file and organize your media and project files.

This lesson introduces valuable approaches to project management. Though it may 
not be the most exciting subject, it is potentially the one that will save the most 
time and energy in the long term.

Getting started (p. 422)

The Project menu (p. 422)

•	 Project menu commands (p. 423)

•	 Making a clip offline (p. 423)

Using the Project Manager (p. 424)

•	 Working with a trimmed project (p. 426)

•	 Collecting files and copying them to a new location (p. 426)

Final project management steps (p. 428)

Importing projects or sequences (p. 429)

Managing collaboration (p. 430)

Managing your hard drives (p. 430)

Sidebars for discussion as time allows

•	 Media management with Dynamic Link (p. 431)

Goals and objectives for this lesson
This lesson consolidates concepts introduced in earlier lessons that relate to media 
and project management. The relationship between clips and media files is revis-
ited, with advice about approaches to creating an organizational system to get 
ready for post-production workflows across multiple projects.

Students will learn how to use the Project Manager, import projects, manage col-
laboration, and keep hard drives organized. 



ADOBE PREMIERE PRO CC CLASSROOM IN A BOOK  69

The File menu
It is important that your students understand the relationship between clips and 
media files, and this is an excellent opportunity to make sure everyone is perfectly 
clear about the difference between the two. Adobe Premiere Pro is designed to give 
the impression that the clips you work with are the media files they link to.

Creatively, this is excellent, because it allows editors to focus on their content, 
rather than their technology. However, it can lead to confusion if editors believe 
they are copying original files as they create a sequence. They might easily delete 
important files, for example, if they mistakenly believe they don’t need them any 
longer.

Using the Project Manager
The Project Manager can be used to achieve two different goals. One is to reduce 
the amount of space taken up by a project. The other is to use the same amount 
of space but to collate all associated files into a single location to make it easier to 
transfer to another editing system or to make it easier to identify which files are 
needed.

To give some context to the descriptions given in the book, you may want to begin 
with a classroom discussion about the different circumstances under which your 
students might need to use the Project Manager.

Importing projects or sequences
Adobe Premiere Pro makes it very easy to import the contents of one project into 
another. During this section, there is scope for a classroom discussion about work-
flows that might benefit from this feature. For example, different teams might work 
independently on sequences in projects that are ultimately intended as parts of one 
larger final project.

It might be interesting to discuss the pros and cons of this approach and the work-
flow for collaboration that might be suitable. For example, how might a group of 
independent editors ensure their work has a consistent look and feel? What naming 
conventions might be used for files, clips, sequences, and projects?

Managing your hard drives
Because Adobe Premiere Pro does not manage your media files, it is a good idea 
to plan ahead and manage media in advance of editing. Some organizations use 
particular naming conventions, while others might use network-based storage with 
limited access based on user logins.

Depending on the class, your students might find it valuable to discuss the chal-
lenges associated with media management in their particular editing environment.
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Review questions

Q	 What is a limitation of the Batch List feature?
A	 It can’t link to audio-only or video-only files.

Q	 What is a handle in the context of the Project Manager?
A	 It’s extra head and tail frames that can be added when the clips are managed 

that allow for longer transitions or slight editorial changes. A handle allows long 
clips to be reduced to only what is used (plus a little extra).

Q	 Why would you want to use just a single sequence as a source for the Project 
Manager (as opposed to the entire project)?

A	 A single sequence source works well when you want to back up just a specific 
sequence or sequences.

Q	 Can you import sequences into a project?
A	 Yes, just import one project into another and choose the desired sequences.

Q	 What kind of file assists when transferring media from a Final Cut Pro project?
A	 An XML file.

Q	 What kind of file assists when transferring media from an Avid Media 
Composer project?

A	 An AAF file.

Q	 You are working with very large media files but want to temporarily edit on 
the move, using a laptop with a small hard drive. How can you temporarily use 
smaller, more heavily compressed versions of your media files?

A	 As long as the file type remains the same, you can link your project to any 
versions of your media files. Convert your original files to a small file size and 
rename the original folders containing your clips so that Adobe Premiere 
Pro searches for the files the next time you open the project. Direct Adobe 
Premiere Pro to your new, smaller files. When you are ready to work with the 
larger files again, reverse the process. No particular changes need to be made 
to your project.

Q	 How can you make a clip offline?
A	 Right-click the clip in the Project panel, or go to the Project menu, and choose 

Make Offline.

Q	 Why might you want to include preview files when moving a project and its 
media to another drive?

A	 Some effects, particularly third-party effects that are not designed to use 
hardware acceleration, may take a particularly long time to render. If you have 
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rendered them already, bringing the preview files along with your other media 
files saves you from rendering them again.

Q	 After using the Project Manager to create a new project, what happens to the 
original unused media files?

A	 Nothing. Adobe Premiere Pro will not delete your original media files. This is 
useful because it allows you time to check whether the options you chose were 
correct and that your new project contains the right clips before you manually 
delete the old files.

Q	 Why might you want the Project Manager to rename newly created media files, 
based on the clip names?

A	 It is common to rename clips to make it easier to find the content you want. 
However, when you do this, the original media filenames remain unchanged. 
If you don’t need to be able to relate your new media files to the originals, then 
it might make it easier to stay organized if the clip names and media filenames 
match.

Q	 Are Dynamic Link assets, including After Effects compositions, supported by 
the Project Manager?

A	 The Project Manager does not collect or trim Dynamic Link assets like After 
Effects compositions. If you have used assets of this kind, manually copy the 
After Effects projects to the new Adobe Premiere Pro project location. Be sure 
to also copy the project files used by the After Effects project.

Module 18:  
Exporting Frames, Clips, and Sequences
•	 This module uses Lesson 18 in Adobe Premiere Pro CC Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.

Many students will find this lesson extremely helpful. This is because they will need 
to share their work or client projects. Adobe Premiere Pro CC offers a wide range 
of export options—methods of recording your projects to tape or converting them 
to additional digital files.

Getting started (p. 436)

Overview of export options (p. 436)

Exporting single frames (p. 437)

Exporting a master copy (p. 439)

•	 Matching sequence settings (p. 439)
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•	 Choosing another codec (p. 440)

Working with Adobe Media Encoder (p. 442)

•	 Choosing a file format for export (p. 442)

•	 Configuring the Export (p. 444)

•	 Source and Output panels (p. 440)

•	 Queuing the export (p. 447)

•	 Additional options in Adobe Media Encoder (p. 449)

Exchanging with other editing applications (p. 450)

•	 Exporting a Final Cut Pro XML file (p. 450)

•	 Exporting to OMF (p. 451)

•	 Exporting to AAF (p. 452)

•	 Send to Adobe SpeedGrade (p. 454)

Recording to tape (p. 456)

•	 Preparing a project for tape output (p. 457)

•	 Preparing a tape for output (p. 457)

•	 Recording to a DV or HDV deck (p. 457)

•	 Using third-party hardware (p. 458)

Sidebars for discussion as time allows

•	 Using the formats (p. 447)

•	 Working with edit decision lists (p. 452)

Goals and objectives for this lesson
In this lesson, students will learn how to choose the right export options for a vari-
ety of conditions. This will include exporting single frames as still images as well as 
creating movie, image sequence, and audio files. They’ll learn how to create many 
different type of outputs as well using the companion application Adobe Media 
Encoder.

Besides digital output, students will learn how to exchange data with other tools. 
This includes exporting an XML file for Final Cut Pro, creating AAF files for Avid 
Media Composer, and using the older fallback method of an edit decision list 
(EDL). Finally, if the gear is available, the student should learn the essentials of 
outputting for tape.
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Overview of export options
It’s important that students understand that exporting is a somewhat complex and 
multifaceted aspect of a project. They can export an entire sequence or just a single 
frame; and they can export the video, audio, or both. Additionally, they should 
understand the difference between final files and intermediate review files as part 
of the creative process.

Exporting single frames
While an edit is in progress, there may be a need to quickly export a still frame to 
send to a team member or client to review. This might be for a quick approval or to 
check an item such as color grading or spelling. Additionally, exporting stills can be 
used as thumbnails for video-sharing sites or as part of web postings. The Export 
Frame function is easy to use and understand. Do raise the issue of square vs. 
nonsquare pixels, which may require stretching to resize the image for use in print 
or multimedia.

Exporting a master copy
Creating a master copy allows the editor to make a pristine digital copy of the 
edited project that can be archived for future use. A master copy is a self-contained 
digital file that contains all of the content of a sequence at its highest resolution and 
best quality. Once created, it can then use that file to produce other compressed 
output formats (often called a mezzanine file). Students can easily match the set-
tings of the current sequence or choose a less-compressed preset option.

Working with Adobe Media Encoder
Adobe Media Encoder is a full-featured compression program that is included 
with Adobe Premiere Pro. One of the key benefits in using it is that it allows for an 
editor to encode video in the background while continuing to edit the project. The 
software offers easy-to-use presets but can be quite powerful in its ability to gener-
ate custom output.

Exchanging with other editing applications
Adobe Premiere Pro allows projects and data to be easily exchanged with other 
video tools (including other manufacturers). Output methods include Final Cut Pro 
XML (which is used not just by Final Cut Pro 7 but also applications like DaVinci 
Resolve). OMF files can be generated to exchange audio data to digital audio work-
station applications like ProTools. Avid systems can use the AAF material gener-
ated by Adobe Premiere Pro to exchange project data and media. Projects can also 
be sent to Adobe SpeedGrade for advanced finishing and color grading.
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Recording to tape
If a tape deck is available, students should learn how to record a project to tape. 
This will complete the loop of capturing from tape earlier in the course. If hardware 
is not available, still review the export-to-tape process detailed in the lesson. Be 
sure to also address the third-party ecosystem for advanced output cards.

Review questions

Q	 What’s the name of the software application that handles all the video 
compression for the Adobe digital video tools?

A	 Adobe Media Encoder.

Q	 What are the advantages and disadvantages of the Use Previews check box 
when you’re exporting media?

A	 If you select Use Previews, Adobe Premiere Pro and Adobe Media Encoder will 
use any existing previews that have been created to accelerate compression 
time—at the cost of quality. By deselecting this option, Adobe Premiere Pro and 
Adobe Media Encoder will create compressed files at a higher quality because 
the original source media will be referenced.

Q	 Name some of the formats Adobe Media Encoder encodes to.
A	 AIFF, AVI, Bitmap, DPX, GIF, JPEG, MP3, P2 Movie, PNG, QuickTime, Targa, 

TIFF, WAV, Flash (FLV and F4V), H.264, MPEG-4, MPEG-2, and WMV 
(Windows only).

Q	 Why would you choose to make a clip offline?
A	 If you’re working with low-resolution copies of your media files, you’ll want to 

make your clips offline so you can recapture them or reimport them.

Module 19:  
Authoring DVDs with Adobe Encore
•	 This module uses Lesson 19 (a PDF on the DVD) in Adobe Premiere Pro CC 

Classroom in a Book.

•	 Sidebar information in the lesson (yellow boxes) can be used as appropriate.

Adobe Encore CC offers powerful DVD, Blu-ray, and Flash web DVD authoring in 
a highly user-friendly package. While file-based media delivery is increasingly the 
norm, physical media is still in demand. Much of the Adobe Encore interface will 
be familiar to your students, now that they have spent some time learning Adobe 
Premiere Pro, because Adobe ensures interface design is as similar as possible 
between multiple applications.
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However, there are some key differences. Adobe Encore is not intended for video 
editing. The focus is on combining multiple media elements that have already been 
created to produce a multimedia, interactive experience.

Getting started (p. 19-2)

Overview of DVD authoring in Adobe Encore (p. 19-3)

Adding Adobe Encore chapter markers to the Timeline (p. 19-5)

Creating an Autoplay DVD (p. 19-7)

Creating a Menu DVD (p. 19-10)

Previewing the DVD (p. 19-15)

Creating a Blu-ray Disc (p. 19-16)

Exporting DVD projects for the Web (p. 19-17)

Sidebars for discussion as time allows

•	 About video files for DVD and Blu-ray Discs (p. 19-5)

•	 Adding chapter marks before transcoding (p. 19-6)

•	 What is the first play item (p. 19-8)

•	 Modifying a menu with Adobe Photoshop (p. 19-15)

Goals and objectives for this lesson
This lesson shows an ideal workflow for sharing an Adobe Premiere Pro CC 
sequence on DVD or Blu-ray Disc. The workflow is different in this release specifi-
cally. The option to dynamically link Adobe Premiere Pro sequences with Adobe 
Encore projects is not available. Be sure to go through the workflow as described in 
this lesson to be well prepared for questions in the classroom.

Overview of DVD authoring in Adobe Encore
All of the lessons until now, except one, have focused on working with clips in the 
Project panel and in the Timeline panel in Adobe Premiere Pro. The exception is 
where you have worked with titles, because the Adobe Premiere Pro Title Designer 
uses a system of object-oriented design that is very similar to the one employed by 
Encore.

You may find it helpful to remind students that the Adobe Premiere Pro Title 
Designer works by users selecting an object and then making changes in the 
Properties panel.

As much as possible, remind your students of the similarities between panels in 
Encore and the panels they know already in Adobe Premiere Pro. There are clear 
parallels between the two applications.
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Adding Adobe Encore chapter markers to the Timeline
You may want to take a moment to show your students how to add Encore chapter 
markers in Adobe Premiere Pro, because they are used in a later section. Your stu-
dents should already feel comfortable adding, moving, and removing markers using 
Adobe Premiere Pro, and the process is very similar when working with Encore.

Notice that the Chapter Marker button has been removed from the Adobe 
Premiere Pro Timeline in this release. To create a chapter marker, go into the prop-
erties for an existing sequence marker and change it to a chapter marker.

The option to add a chapter marker can have a keyboard shortcut assigned, and you 
may find it faster and easier to use this option.

Creating an Autoplay DVD
While Encore has powerful interactivity features, it is quite likely your students 
will want to produce this most basic form of DVD or Blu-ray Disc. You may want 
to give a little extra time to this particular section to be sure your students are all 
comfortable with creating an autoplay DVD or Blu-ray Disc.

This kind of disc requires the least understanding and the fewest mouse clicks. If 
your students use the Dynamic Link workflow, they won’t even need to think about 
file types.

Creating a menu DVD
easy to find on the Adobe website, if it isn’t installed already, but it’s quite large. If 
your classroom Internet connection isn’t particularly fast, consider downloading 
the installer in advance.

The exercise in this section makes use of a library asset, partly to show that it is 
possible and partly to save time in the classroom. If you have more time available, 
you could easily show the same features while building a new menu from a blank 
start.

Previewing the DVD
Note that if you have chosen to create a more complex menu with motion, you 
will need to render the menu before you can preview it fully. Go to File > Render > 
Motion Menus to do this if you need.

Previewing your project is an excellent way to check that disc interactivity works 
as planned. Time permitting, you may also want to introduce the Flowchart panel, 
which shows the relationships between each element in your project. You may 
also want to show the Check Project option in the File menu or in the Build panel, 
which will flag any missing links or problems with your interactive design.
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Review questions

Q	 What’s the default video format for a standard-definition DVD?
A	 MPEG-2.

Q	 How can you create chapters within Adobe Premiere Pro?
A	 You can add interactive markers to a sequence.

Q	 What are the two major types of projects you can build in Adobe Encore?
A	 You can create an autoplay or menu-based project.

Q	 What are the two methods of getting your Timeline to Adobe Encore?
A	 You can use Dynamic Link or export and precompress a file using Adobe Media 

Encoder.

Q	 Which formats can you author in Adobe Encore?
A	 You can create a DVD or Blu-ray Disc. You can also create a Web DVD, which 

uses Flash Video and adds interactivity.

Q	 How is the Encore interface similar to the Adobe Premiere Pro Title Designer?
A	 Both Encore and the Adobe Premiere Pro Title Designer make extensive use of 

a Properties panel to make changes to objects you select. In the case of Encore, 
the Properties panel is also used to create links between objects for interactivity.

Q	 Are you obliged to keep library assets in their original form?
A	 The library assets are completely editable, and you can learn a lot about building 

your own menus by opening one up in Adobe Photoshop.

Q	 What is the difference between the Selection tool and the Direct Select tool?
A	 The Selection tool selects objects like buttons as a single item, while the Direct 

Select tool will select individual parts of a button, allowing for precise editing 
(but making it impossible to drag and drop a button to move it).

Q	 Is there any difference between the chapter markers you can add to a sequence 
in Adobe Premiere Pro and the chapter markers you can add in Encore?

A	 No, they are exactly the same. You can save time by adding chapter markers in 
Adobe Premiere Pro, ready for using Dynamic Link to share the sequence with 
Encore.

Q	 How can you tell which is your First Play item in Encore?
A	 Your First Play item will be marked with a small black triangle in a circle.
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Q	 Why do you need to choose between Blu-ray and DVD disc types when creating 
a new project?

A	 Blu-ray Discs have more interactivity options than DVD discs, so it’s important 
to tell Encore which kind of project you are working on in order to have 
the correct options available. If you don’t plan to create a disk with much 
interactivity, it may not make a difference, because you can change the output 
format in the Build menu.
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